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FOREWORD

The purpose of this publication is to help foreign students of KubSMU in preparation for
lectures and practical classes in medical informatics, independent study of the material of the
discipline.

The analysis of the material presented in the manual will allow the student to get ac-
quainted with the main provisions, problematic issues of the upcoming lecture, which is especial-
ly important in preparing for interactive forms of work, and will also help in organizing the stu-
dent's independent work on specific topics. The tasks contained in the manual will help to con-
solidate and subsequently identify the knowledge and skills of students.

The material presented in English summarizes modern scientific and practical knowledge
in the field of medical informatics, and allotted blank lines for recording keywords, concepts,
comments will be useful to foreign students in the process of working with the teacher.

The future specialist during the training should not only master the curriculum, but also
acquire the skills of planning and performing independent work, which will allow, at a high sci-
entific and methodological level, to investigate the various processes and patterns of functioning
and reforming the modern health care system in a market and competition .

The development of the material presented in the textbook is aimed at building students'
knowledge of the basics of medical informatics; ability and willingness to analyze problems that
arise when working in the medical information space; the ability to use modern methods of
working with digital information

This tutorial is adapted to understand information processes, the principles of categoriza-
tion and mechanisms for working with information, as well as aspects of information security by
foreign students of medical universities.

The lecture workbook presents the supporting abstracts of the lecture in accordance with
the subject of the academic discipline, test assignments for self-training and self-monitoring, a
glossary of basic economic terms and concepts, recommended literature.

The success of mastering the teaching material is achieved in the process of joint activity
of the teacher and student, taking into account their individual capabilities, accessibility of the
teaching material.



INPEANCJIOBHE

Llens HACTOSAIIErO0 WM3IaHHUS — IMMOMOYb MHOCTpPAHHBIM cTyneHTamM KyOoI'MY mpu moaro-
TOBKE K JICKIIMOHHBIM U MPAKTUYECKUM 3aHITHSIM IO MEIUIUHCKON WH(POPMATHUKE, CAMOCTOSI-
TEJIbHOMY U3YyYEHHUIO MaTepHUaia JUCUUIIIINHBI.

AHalii3 U3J0KEHHOT0 B MOCOOMHM MaTepualia MO3BOJIUT CTYACHTY O3HAKOMUTBLCS C OC-
HOBHBIMH IOJIOKEHUSIMH, TPOOJIEMHBIMU BOIPOCAMH MPECTOALICH JIEKIIMU, YTO OCOOEHHO BaX-
HO TPH MOATOTOBKE K MHTEPAKTUBHBIM (hopmMaM paboThI, a Tak:Ke TIOMOXKET B OPraHHU3aIUH Cca-
MOCTOSITEJIbHON pa0bOoThI CTYACHTA MO OTAENbHBIM TeMaM. Cojepikaliuecss B yueOHOM MOCOOUHN
3aanus OyayT CIOCOOCTBOBATH 3aKPETUICHUIO U MOCIIEAYIOMIEMY BBISIBICHUIO 3HAHUH ¥ YMEHUN
oOydJaronuxcs.

[IpencraBneHHbI Ha aHTTTUICKOM S3bIKE MaTepHall, 0000IIaeT COBPEMEHHBIC HAyYHbIE U
MPaKTUYECKHE 3HAHHUS B 00JaCTH MEIUIMHCKON MHGOPMATUKHU, a OTBEICHHBIE ITYCThIe CTPOKH
JUTSL 3aMMCH KITFOUEBBIX CIIOB, MOHATHUNA, KOMMEHTapUEB OYIyT MOJIE3Hbl MHOCTPAHHBIM CTY/ICH-
TaM B IIPOIIECCE COBMECTHOM pabOThI C MpernoiaBaTeseM.

Bynymuii cnenmanuct 3a BpeMsi 00y4eHUs! JOJKEH HE TOJIBKO OCBOHMTH YYEOHYIO IPO-
rpaMMy, HO U MPUOOPECTH HABBIKU IJIAHUPOBAHUS M BBHIMIOJHEHHS] CAMOCTOATEIHHONU paboThI,
YTO MO3BOJIUT HAa BHICOKOM HAay4YHO-METOJIMYECKOM YPOBHE MCCIIEIOBATH Pa3IUYHBIC MIPOIIECCHI U
3aKOHOMEPHOCTH (HYHKITMOHUPOBAHUS U peOPMUPOBAHUS COBPEMEHHOM CHCTEMBI 3/IpaBOOXpa-
HEHUS B YCIOBHUSX PbIHKA U KOHKYPEHIIUH.

OcBoeHMe U3JI0KEHHOTO B y4eOHOM MOcOOUM MaTepHalia HalpaBlIeHO Ha (JOPMUPOBAHUE
Yy CTY/ICHTOB 3HaHMI OCHOB MEAMITMHCKON MH(POPMATUKU; CIIOCOOHOCTH U TOTOBHOCTH aHAJIU3U-
poBaTh MPOOJIEMbl, BO3HUKAIOIINE MpU paboTe B MEIUIIMHCKOM HH(DOPMALIMOHHOM MPOCTPaH-
CTBE; YMEHHS UCIOJIb30BaTh COBPEMEHHbIE METOIMKH PaboThI ¢ M POBOI HHPOpMAITHEit

JlanHoe y4yeOHOe mocoOue ananTUpPOBAHO Jis MOHUMAHUS MH(POPMAIMOHHBIX MPOIIEC-
COB, MPUHIIUTIOB KaTEropu3alii 1 MEXaHU3MOB pabOThI ¢ MHPOpPMAIIHEH, a TaK)Ke aCTIeKTOB WH-
dbopmarmoHHON 0€30MaCHOCTH MHOCTPAHHBIMU CTYJIEHTAMU METUIIMHCKUX BY30B.

B nexnmonHo#t paboueil TeTpaau MpeaCTaBICHBI OMOPHbIE KOHCHEKTHI JIEKIIMH B COOT-
BETCTBHH C TEMAaTUKOW Y4eOHOU NUCIMIUIMHBI, TECTOBBIC 3aJaHUs JIJIsi CAMOMIOATOTOBKH U CaMO-
KOHTPOJIA, T10CCApUil OCHOBHBIX SKOHOMHUYECKUX TEPMHUHOB U MOHATUN PEKOMEHJOBaHHAs JIH-
Teparypa.

YcnemHocTh OBNafeHusl Y4eOHBIM MaTepUaloM JOCTUTAETCS B IMPOIECCe COBMECTHOM
JIeATETLHOCTH TIPENOIaBaTels U CTYICHTa, YUeTa UX WHAUBUAYATbHBIX BO3MOXKHOCTEH, TOCTYT-
HOCTH y4e0OHOTro MaTepuana.



INTRODUCTION

Information technologies are increasingly entering our lives and if 5-10 years ago, in
some cases, it was possible to imagine the activities of a doctor without the use of medical in-
formation systems (MIS), then now this is impossible. Within the framework of the current EH-
HIS system, according to the legislation, each medical case must be included in the existing 1A
database. In order to focus on the use of information systems, to acquire skills in the technologi-
cal information field, students of medical specialties master the discipline “Medical Informatics”.

The competency-based approach to the organization of the educational process at a uni-
versity presents new requirements for a lecture as the leading form of its organization. There is a
transition from the formation of an indicative basis for the subsequent assimilation by students of
teaching material to the co-creation of a lecturer and audience, the activation of students' mental
activity, and the realization of their creative abilities as a result of interactive forms of work. This
makes it necessary to search for new technologies, methods, and techniques that enable students
to engage in cognitive activity.

The correct arrangement of notes, rubrication, emphasis on the main ideas, key words
make the lecture notes more qualitative. In addition, pre-recorded recordings avoid distortion of
factual information. After all, there are often cases when students at a lecture incorrectly write
down the terms, formulas, names of scientists. All these errors can be prevented, saving the stu-
dent from the need to record information of this kind. At the same time, abstracts are allotted
blank lines for recording keywords, concepts, comments. The use of working test is directly re-
lated to the implementation of the principle of visualization, which is a general didactic norm,
due to the need to reinforce verbal explanations with facts, their schematic, graphic and model
representation.

These guidelines have been prepared to assist students in mastering the lecture course of
the discipline “Medical Informatics” taught at the Department of Public Health, Health Care and
the History of Medicine of the Kuban State Medical University. It contains the necessary di-
dactic material that meets the requirements of the GEF 3 program in the areas of medical care,
pediatrics and dentistry.



BBEJEHUE

HNudopmaninoHHble TEXHOJIOTUU BCE IIyO)Ke M TeCHEEe BXOMAAT B HAIly H3Hb U €CH 5 -
10 ner Ha3ax, B OTACIBHBIX CIYYasx, MOXKHO OBLIO MPEICTaBUTH JEATEIBLHOCTh Bpada Oec mpu-
MEHEHHUsI MeAUITMHCKIX nHPpopMannoHHbIX cucteM (MUC), To ceiiyac 3T0 HEBO3MOXkHO. B pam-
kax geiictByromeit cucrembl EI'MMC3, mo 3akoHOIATENbCTBY, KaKIbId MEAMIIMHCKUM ciydai
JOJIKeH ObITh BHECEH B cyliecTByromryto 6azy MUC. C 1enpio OpueHTUPOBAHHOCTH HA HCIOJIb-
30BaHMe MH(OPMAIIMOHHBIX CHUCTEM, IOJYYEHHUS] HABBIKOB pabOTHI B TEXHOJIOTUYECKOM HH(OP-
MAalMOHHOM II0JI€ CTYAEHTHl CHEIUAIUTETOB MEIUUMHCKUX HalpaBlI€HUI OCBaWBAaIOT JHCLIM-
ey «MeaunuHCcKas THPOPMaTHKA.

KoMreTeHTHOCTHBIN MOAXO0J B OpraHU3aluy y4eOHOro Ipolecca B By3€ MPEAbSBIISIET
HOBBbIE TPeOOBAaHMUS K JICKIIMHU, KaK K Beaylel ¢opme ero opranusanuu. [Iporncxomur nepexon
0T (JOPMUPOBAHUS OPUEHTUPOBOYHON OCHOBBI JJIs MMOCJIEAYIOIIET0 YCBOCHUS CTYACHTaAMH Y4eo-
HOT0 MaTepuaja K COTBOPUECTBY JIEKTOpA U ayJUTOPUH, aKTUBHU3AIIUM MBICIUTEIILHON JesATelb-
HOCTU CTYACHTOB, pealu3allid MX TBOPYECKHX CIIOCOOHOCTEW B Pe3ylbTaTe HHTEPAKTHUBHBIX
dbopM paboThL. DTO 00YCIIOBIMBACT HEOOXOIUMOCTD ITOMCKA HOBBIX TEXHOJIOTHI, METOJIOB, IIPHU-
€MOB, IO3BOJISIOLIMX aKTUBU3UPOBATh NIO3HABATEIBHYIO AESATEIbHOCTh CTYAEHTOB.

[IpaBuIbHOE pacIIONOKEHUE 3amuceil, pyOpUKaIus, BbIICICHNE TIIaBHBIX MBICIIEH, KITIO-
YEeBBIX CJIOB JEJIAl0T KOHCIEKT JIeKIMKM Ooliee KauecTBEHHBIM. Kpome Toro, mpeaBaputenbHO
C/IeTIaHHBIC 3aIMCH TIO3BOJITIOT U30€KaTh UCKakeHUs (pakTuyeckoi nHpopmarmu. Benp Hepen-
KM CJIydad, KOTJia Ha JIEKIIUU CTYJIEHThl HEMPAaBUIBHO 3alMChIBAIOT TEPMHHBI, (HOpMYIIbI, haMu-
TUH y4eHbIX. Bce 3TH ommOKM MOXKHO TpeAaylpeauTh, U30aBUB CTYIEHTa OT HEOOXOIMMOCTH
bukcupoBath HHPOPMAIHIO TOJ0OHOTO poja. B To ke Bpemsi B KOHCIIEKTE OTBEACHBI MyCThIC
CTPOKH JIJIS 3aMMCH KJIFOUEBBIX CIIOB, MOHATUN, KOMMeHTapueB. Mcnonb30Banue paboyeit TeTpa-
1 HETOCPE/ICTBEHHO CBSI3aHO C pealin3allield IPUHIIMIA HaTJsSJHOCTH, SIBJISIIOIIErocsl o0Imen
JUIaKTUYECKOM HOpMOH, 00yCIIOBIEHHON HEOOXOIUMOCTBIO TOJKPEIUIEHUS CIIOBECHBIX 00BsiC-
HEHUU (paKTaMu, UX CXEMATUYECKUM, TPAPUIECKUM U MOJCIIBHBIM MPEACTABICHUEM.

Hacrosiumme meroauyeckue peKOMEHIAMU MOJATOTOBJIEHBI JUIsl MOMOIIM CTYJEHTaM B
OCBOEHHUU JIEKIIMOHHOTO Kypca TUCHUIUIMHBI «MeaunuHckas MHQOpMaTHKay, MpPernoiaBacMoi
Ha Kadeape oOIIEeCTBEHHOTO 3J0POBbs, 3PABOOXPAHEHUS] U HCTOpUM MeauluHbl KybaHckoro
roCy/1apCTBEHHOIO0 MEIULMHCKOro yHHuBepcutera. CoaepKUT HEOOXOAMMBIN JTUAAKTHUECKUN
MaTepual, oTBevaronnii TpedoanusiM nporpammbel ®I'OC 3 mo HampaBiaeHUSIM JeuedHoe JIeo,
neAuaTpusi 1 CTOMaToJIOTUsl.



Lecture Ne 1. Introduction to medical informatics. Key terms and concepts

Definition

Informatics — sciences about
methods and processes of col-

lecting, processing, storage,
transferring, analyzing and
evaluating information with

computer technology, that pro-
vides the ability to use it for

making decisions.

Definition

The word Informatics is a complex word
and it made up of two words: the first oneis

information, the second one is automation.
That is, the new meaning of the word

informatics is the automated collecting,
processing, storage and transferring of

second-level information derived on the basis
of primary data (primary information).

)

i+ Computer Creation History

The first generation - computers with vacuum
tubes(1946-1955)

ENIAC - the first computer made MESM - the first Soviet computer,
in 1946 1950




Computer Creation History

Second Generation - Transistor Computers(1955-
1965)

Compared to electronic tubes,
the use of transistors allowed:

sreduce the size of Computer
Engineering

sincrease reliability
sincrease work speed (up to 1
million operations per second)
«get rid of heat irradiation.

CDC Computer 6600

=)

- Computer Creation History

Third Generation - Integrated Circuit
Computers(1965-1980)

~i» Computer Creation History

YeTBepTOE NOKONEHUE - KOMNbLIOTEPDLI C
Mukponpoueccopamu (1980-H.B.)

__1
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CoBpeMeHHbI NepcoHanbHbIN

MepBbLI nepcoHanbHbIN
KOMNblOTEP OT KOopropauuu KoMnbloTep
IBM - 12 aBrycTa 1981 roga




<.+ Computer Creation History

Fifth generation - computers of the near future

* Their main quality should be a
high intellectual level.

* They will be possible input from
the voice, voice communication,
machine "vision", machine
"touch".

* To increase memory and speed,
will be used the achievements of

optoelectronics and
bioprocessors.

Definition of Information

1. Information is an attribute of the ex-
istence of matter.

Information is a measure of the distribution
of mass and energy in space and time.

n

Information Features

« Objectivity - does not depend on anything opinion.

* Veracity —reflects the true state of affairs.

« Completeness - sufficient for understanding tasks
and making decisions.

* Relevance — important and necessary for the present.
« Significance - (usefulness, value) provides a solu-
tion of the tasks, is needed in order to make the

right decisions.
« Clarity - expressed in a speech accessible to
the recipient.
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Information Features

In addition, the information has other properties:
Attribute Properties

« discreteness (information consists of separate parts, signs);
« incessancy (the ability to accumulate information).

Dynamic properties are associated with a change in infor-
mation over time:

copying — duplication of information;

« transmission from source to consumer;

< translation from one language to another;

« transfer to another medium;

« aging (physical - medium, moral - value).
Practical properties - information volume and density.

10

Information classification

By the methods of perception:
* visual
« audial
* tactile
« olfactory
« flavoring

11

Information classification

By representation forms:
textual;
numerical;
graphic;
musical,
combined etc.

12




£
,u' ""\'j

Data is a objects
or phenomena,

presented in the
form of symbols,
signs, numbers.

13

s

“Definition of medical informatics

Medical informatics — the science of the
processing, transformation, storage,
transmission and presentation of information
in medicine.

14

The problem of medical
Informatics

1. the population health status monitoring;
2. clinical medicine advisory support;

3. switch-over to electronic case histories
and outpatient cards;

4. automation of functional and la-
boratory diagnostics.

15



s

Classification of Medical
Information

« alphanumeric,
* visual,

+ audio,

+ combined

16

Storage medium

Storage medium — any material object or
environment used by man, capable for
storing (carrying) in its structure the data
recorded on it for along time, without the
use of additional devices (for example, an
energy source).

17

19 Media Classification

L A
By nature of medium:
» Material-subject (books, hardware storage devices);
» biochemical (DNA, RNA, etc.);
« According to the main purpose:
« general (wide) purpose (for example, paper);
« specialized (for example, designed only for digital recording).
« By the number of recording cycles:
« for single recording;
« for multiple recording.
By durability:
- for long-term storage (termination of the media function
due to random circumstances);
for short-term storage (termination of the function is due to regular
processes leading to the inevitable degradation of the carrier).

18
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Eelectronic devices

Electronic devices includes media for one-time or
multiple recording (usually digital) by electrical
method:

+ optical (CD-ROM, DVD-ROM, Blu-ray Disc);

» semiconductor (flash-memory, floppy disk)

19

= Electronic media
Electronic media has significant advantages over paper:

* by volume (size) of stored information;

» at the unit cost of storage;

« on the cost-effectiveness and efficiency of providing

relevant (intended for short-term storage) information;

» if possible, provide information in a form handy

for the consumer (formatting, sorting).

*Disadvantages :

« fragility of readers;

* weight (mass), in some cases;

» dependence of power supplies

» the need for a reader/writer for each type and for-

mat of media.

20
& Memory device
Information storage devise consist of these
elements:

« Data storage;

« recording device — mechanisms for re-
cording information on a medium;

« information reader — mechanisms for read-
ing information from storage medium.

21



Information units

* Bit — the smallest information unit. It can take
only one value (1 or 0, yes or no, true or
false).

* Byte — basic unit of information amount.
1 byte = 8 bit
1 Kb = 1024 byte

22
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Information units
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Lecture Ne 2. The concept of Informatization. Strategy of transition to information soci-
ety. Information technology hardware

P
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Computer device

Any PC consists of

’ 4 1Y

| Hardware | Software
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(4| Microsort ]Topfosuix napmiep
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“ Computer hardware
It is a system of interconnected technical devices
designed for input, processing, storage and output of
information
S lﬁ §
& =
2

2

Motherboard

Motherboard this is the main Board of the system unit. On
it are connectors for connecting all other parts-graphics

card, RAM, processor, etc. Throwing computer terminology,
the motherboard-the base of the computer. As we said
before-and RAM and processor play a major role in the
computer




Processor

Central processor(CP; also Central processing unit CPU)

— an electronic unit or integrated circuit (microprocessor), executing
machine instructions (program code), the main part of the hardware of
acomputer or a programmable logic controller.

« The main chip that performs arithmetic
and logical operations — "computer brain".

*. Classification of processors
By the number of large integrated circuits in a
microprocessor set:

« Single chip

*  Multichip

* Multi-sectional

As intended:

* Universal

* Specialized

By the nature of the temporary organiza-

* Synchronous

« Asynchronous

By the number of programs executed:
« Single-program

* _Multiprogramming

5

Processor model

The most popular processors today are produced
by firms:

Intel, AMD u IBM.




Intel

At the moment 3 families (lines) of desktop processors
of the Intel company are widespread

Celeron —the weakest, stripped-down version of the
Pentium, then go Pentium and the most modern and
productive- Core i

Intel

All Core I3 models are dual-core, have 512 KB L2 cache, built-in Intel HD Graphics video
subsystem and are divided into I3-xxx and i3-2xxx series. New 13-2xxx processors running
on the lgal155 socket have 3 MB of third-level cache.

Core i5, the LGA1156 socket-equipped models are divided into i5-6xx and i5-7xx series. The
i5-6xx line CPUs are dual-core like the Core i3, have a built-in video chip, 512 KB L2 cache
and 4 MB L3 cache. The new family of Quad-core Core i5 processors is marked with a four-
digit number (for example, Core i5-2400), has a built-in video core, 1 MB L2 cache, 6 MB L3
and is designed to be installed on the socket LGA1155.

The Intel Core i7-xxx are Quad core (with the exception of "extreme" six-core model Core i7-
970/975/980X), does not have integrated GPU, | have the second level cache of 1 MB, the
third level is 8 MB and is designed for installation on the socket LGA1366 (series i7-9xx) or
LGA1156 (i7-8xx).And finally, the most modern line of processors Core i7-2xxx. These mod-
els are designed to run on the socket LGA1155, have a built-in video core.

3rd Generation Intel” Core™ Processor Family

ii:ltel' Insige~ GNPt

CORE i7

antelD -

~Core s CORE iS5

AMD

The most common lines of processors today are A-series, Athlon
11, Phenom Il and FX. All modern Socket AM3/AM3+ processors
have standard system bus frequencies equal to 4000/5000 MHz
respectively.

A-series-the” weakest " among AMD processors, designed for office
configurations. It has a built-in video core and is designed to be installed
on the FM1 socket. Analogue of the previous generation models called
"Sempron" and Celeron processor from Intel

Athlon-universal processor of medium-high power, designed to
work on socket AM3/AM3+ or Socket FM1 (new models). Similar to
Intel Pentium and Core i3/i5.. Series X2 2xx-dual-core, X3 4xx-tri-
core, X4 6xx-Quad. The three-digit number depends on the cache
size (1to 4 MB) and the processor clock speed.

New FX series processors are marked with a four-digit number, in -
which the first digit indicates the number of cores (4, 6 or 8), and,
accordingly, the volume of the L2 cache. These processors are
perfect for modern gaming configurations




AMD

* Phenom —-processor for game con-
figurations of system units. The six-
core models have performance
comparable to the Core i5-2xxx and
Core i7 series processors.

» Processors called Phenom I
are two- (X2), four- (X4) and
six-core (X6).

* Phenom Il X6 six-core proces-
sors are one of the most pow-
erful processors currently
produced by AMD.
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o5 Macintosh

Macintosh (Mac)—a line of personal computers designed,
developed, manufactured and marketed by Apple. They work
under the Mac OS operating system. Macintosh computers can

be used for the same tasks as computers running Windows and
systems based on the Linux kernel. There is a wide range of
software applications, including Microsoft Office for Mac, Adobe
Photoshop etc. Also Macintosh are widely used in the field of

/ computer graphics, printing and recording. The move to Intel
pr rs greatly and the operation of
. \ virtual machines that run virtual operating systems. Moreover,
the Boot Camp project is currently implemented, which allows

| you to install and run other operating systems on the Macintosh
and boot into one of them .

Windows XP and Windows Vista, Windows 7 are already supported. Can be installed
independently adaptable from Apple Linux distributions this initiative turns the MACINTOSH into

a UNIVERSAL COMPUTER, which is AVAILABLE for a VARIETY of OPERATING SYSTEMS for
INTEL PROCESSORS.

11

& Video card

Video card-a device that converts a graphic image stored as the
contents of the computer's memory (or the adapter itself) into a
form suitable for further output to the monitor screen

12
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<+ Computer's memory

memory is the most important
characteristic of a PC

PC MEMORY

7 \

| .

RANBE@M PERMANENT CACHE MEM@RY
ACCESS MEMeRY
MEM®RY
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PC Memory

* The permanent memory * Random access memory
(ROM) stores information (RAM) - electronic
recorded at the enterprise memory for storing

and manufacturer, includes programs and data that
are processed by the

basic system programs that processor at a given time.
automatically run when you When the computer is

turn on the computer and powered off, the
are designed to check the information in the RAM is
health of the computer and erased.

the initial boot of the
operating system

= N
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The permanent memory

« Permanent memory (RO. ROM, Read Only) -
non-volatile memory, used to store data that
will never require changes. The contents of
the memory are specially "sewn" into the de-
vice during its manufacture for permanent
storage. ROM can only be read. First of all, a
program for controlling the operation of the
processor itself is recorded in the permanent
memory. The ROM contains programs to
control the display, keyboard, printer, exter-
nal memory, programs to start and stop the
computer, testing devices. The most im-
portant chip permanent or Flash-memory-
module BIOS. BIOS (Basic Input/Output Sys-
tem- basic input / output system) - a set of
programs designed for: automatically test
devices after the computer is powered on-
loading the operating system into RAM




Random access memory

RAM is one of the main elements of a computer. "Operational” memory
because it is very fast and allows the processor to read information
from memory almost without any noticeable waiting. The data stored in
the RAM is stored and available only when the computer is turned on.
When you turn off the computer, the content is erased from memory,

so you must save all data before you turn off the computer.
The amount of RAM (by the way, it is also called RAM — random access
memory) depends on the number of tasks that can be performed
simultaneously by the computer

16

Organization of RAM

« Physically, RAM in a system is a set of chips or
modules containing chips that are usually con-
nected to the motherboard. These chips or mod-
ules can have different characteristics and, to
function properly, must be compatible with the
system in which they are installed. The term
"RAM" often refers not only to the chips that make
up the memory devices in a system, but also in-
cludes concepts such as logical mapping and
placement. The logical mapping is a way of repre-
senting memory addresses for the chips are actu-
ally installed. Placement is the location of infor-
mation (data and commands) of a certain type at
specific memory addresses of the system.

17

S Dynamic random access
memory

DRAM (Dynamic Random Access

Dynamic RAM

. Memory) Dynamic storage device
can be Of dlf' with arg?trgry sampling grder“
ferent types: « At the moment the most common

are three types of memory : DDR,
DDR2, DDR3.

« The worst one is DDR, and the newest
and best is DDR3. Memory types differ in
the transmission rate: DDR: 200-400
MHz, DDR2: 533-1200 MHz, DDR3: 800-
2400 MHz. Accordingly, the higher the
frequency, the faster everything works.

18




* SDRAM (Synchronous DRAM). This type of memory was
used in legacy systems of the Pentium I/Il/ll class, in the
first releases of Pentium 4, as well as in similar models
with AMD processors. SDRAM memory was available in
several versions, differing in operating frequency: RS66
(66 MHz), RS100 (100 MHz), RS133 (133 MHz). The faster
PC100/PC133 modules do not work on PC66-only boards.

+ DDR SDRAM (Double Data Rate SDRAM), this memory runs
twice as fast. The OPA was used in systems based on Pentium
IV (Celeron) AMD Athlon (Sempron) processors, but since 2008
motherboards with DDR RAM are no longer available

+ DDR2. This memory is afurther development of DDR technology
DDR2 memory modules are widely used in modern computers
and are available in several versions, different clock speeds.
DDR2 modules can have the designations DDR2-400 (PC2-3200),
DDR2-533 (PC2 - 4200), DDR2-677 (PC2-5300), DDR2-800 (PC2-
6400) and DDR2-1066 (PC2-8500).

« DDR3. The memory of this standard allows you to trans-
fer 8 data packets per clock cycle. At the time of writing,
it is supported only by the newest chipsets, such as Intel
P35, X38 and X48

DDR 3RAM

19

Amount of RAM

* It's no secret that almost all PC users tend to increase
the amount of RAM. This is natural, because the larger
the amount of RAM, the faster all currently running
processes. This is especially important for gamers,
because the larger the amount of RAM on the comput-
er, the faster the gameplay will be.

* The most common amounts of RAM now on computers: 1,
2, 3, 4 GB. This volume can consist of a single line (Board)

«» External memory organization

External (auxiliary) memory Is a long-term nonvolatile memory
for storing data (programs, texts, calculations, etc.).

Unlike RAM, external memory has no direct connection to the
processor. Information from the ESD to the processor and Vice
versa circulates approximately the following chain:

ESD #* |SD ** Cache** Processor
This type of memory is implemented by external storage
devices located, as arule, in the system unit or outside it.
To work with external memory, you must have a drive
and media.
Drives-devices for recording and (or) reading information.
Media-devices for storing information.

21




v 4 . .
<. External memory organization

The most common are the following types of drives:

1) hard disk drives (HDD);

2) drives floppy disks
3) magneto-optical compact disc drives; m
4) optical disk drives (CD-ROM);

5) the tape drives,etc.

22

Hard disk drives (HDD) is a high-capachty

storage device in which data carriers afe

non-replaceable round hard plates, both
surfaces of which are covered with a /el
layer of magnetic material. Hard magnéts
ic disks are placed on one axis, they ared
enclosed in a metal body and rotating at
high angular speed.

In comparison with disk drives hard
drives have a number of very valua-
ble advantages :

« the volume of stored data is
immeasurably larger (up to « Manufacturer:
several thousand GB), Seagate, Maxtor, Western

« access time at the hard drive is Digital, Hitachi, Samsung

much less. -+ Capacitance :
4000 Gb

Rotational speed : 7200rp/m,
10000rp/m

- Connection : IDE, SATA, SCSI

23

= Floppy Disk Drive

« Floppy Disk Drive as a storage
. medium use floppy disks-small

5,25” (inches’) amount of information that are de-
signed to transfer information from
one computer to another.

+ Any magnetic disk is not initially ready
for operation. To bring it into working
condition it must be formatted.

+ When formatting, the disk surface is
divided into magnetic concentric tracks
divided into sectors. The number of
tracks and sectors depends on the type
and format of the floppy disk. The sec-

- J N tor stores the minimum amount of in-

=i m‘M_ formation that can be written to disk or

read. The sector capacity is constant at

512 bytes.

peponen

paspeLueHue 3anuc

1,44 MB
300 rp/m




Magneto-optical disc

A magneto-optical disk is a data carrier combining
the properties of optical and magnetic storage devices.
For the first time magneto-optical disc appeared in the
early 80-ies

A magneto-optical disk interacts with the operating
system as a hard disk, so it can be formatted into a
standard file system (for example: FAT, NTFS, HPFS,
etc.)

Advantages:
Low susceptibility to mechanical damage
Weak susceptibility to magnetic fields
Guaranteed quality of the recording

25

The magnetic tape drives

Streamer also a tape drive — storage device on the principle of magnetic
recording on tape, with sequential access to data, the principle of operation

is similar to a household tape recorder.

Main purpose: recording and playback of information, backup and restore
data

Advantages:

High capacity;
Low cost and wide storage conditions of in-
formation media;
Stability of work;
Reliability;

Low power consumption for a large tape library.

26

Optical (laser) CD and DVD discs

« Optical disk drives are devices that record information and read infor-
mation using laser radiation.

« Information is recorded on two main types of disks-CD (Compact Disk)
with a capacity of about 700 MB and DVD (Digital Video Disk) with a ca-
pacity of several GB.

* Audio CD (compact

> disk) Diameter 12 cm
/" \ CD-ROM, CD-R, CD-RW:
( = 650-700 M6
\ 4 CD-ROM - reading

CD-R-single recording

CD-RW — multiple recording
mini-CD (-R, -RW)

diameter 8 cm

210 M6




.r DVD - Digital Versatile Disk unu Digital
o Video Disk
a laser with a shorter wavelength

two-layer 22
single-layer ynilateral
unilateral =

]
Tafre i
FA DVD-ROM -only reading
DVD-R, DVD+R =single recording
= bilateral 17,176  DVD-RW, DVD+RW —multipl
bilateral e{a J' ! R i multipie
?l recording

(1000 cycles')

A ad
f‘ !\ :#\-\__\,T/_- DVD-RAM - multiple recording

(100000 cycles') 4
=
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No)
N
i Flash memory
Flash memory is a non-volatile type of memory that
allows you to record and store information on chips.
Flash-memory provides high data safety, high speed of
writing and reading of information at small sizes. Flash-
based devices do not have moving parts in their
composition, which ensures high data safatgtwhdreused
in-mobile devices. | o o

USB Flash wocuTens }

(noxasano uagenue dupmsl

L) Saitek, UNMOCTPAUMA W3

- Bukinenm) -/

1 USB pasvém
2 Ko

6 Ceeroamon
7 Mepexniosatent «aaumra
or 3anucis F
8 MeCTo 418 A0NONMHTENbHOR W
MUKDOCKEMb NaMATH
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Printers

« A printer is a printing device that can
be used to make a "hard" copy of a
document on paper, cardboard, trans-
parent film, or other media.

30



% Classification of printers by
printing technology

Matrix
Inkjet
Laser
LED-printers
Printers with dye phase
Thermal sublimation printers
Printers with thermal transfer of wax mastic

31

Main user characteristics:

« Format-normal format allows you to print on A4 paper (210x297 mm), wide
—on A3 paper (297x420). In addition to these most common sizes, there are
also printers A2, Al and AO (the latter are often called inkjet plotters), they
are usually used in design studios and design offices.

» Resolution - the value of the smallest details of the image transmitted
when printing without distortion. Measured in dpi (dot per inch) — the
number of individual dye points applied per inch of paper.

* Number of colors.

« Performance — the number of characters or pages printed per second or
minute. It is measured for matrix printers in cps (character per second) —the
number of characters printed per second, for inkjet and laser printers in
ppm (pages per minute) — the number of pages printed per minute.

32

Matrix printer
Characteristics:

Resolution 72 - 360 dpi

Number of colors | one color

Performance small

33




ink ribbon
printhead

needles

34

¥4
“Advantages and disadvantages
of matrix printers

Advantages Disadvantages

sLow price of the printer and-Average print quality.
consumables.
*High noise level.
*The ability to print under the
copy tracing paper.

*Not demanding of paper.

35

Inkjet printer
Characteristics:

Resolution Till1440 dpi

Number of colors |one color(black) or four colors

printing a little longer

Performance Printing in normal quality mode is 3-4 ppm. Color




3

Prmmple of operation

printhead

37

)

Laser printer
Characteristics:

Resolution 600 — 1200 dpi

Number of colors |onecolor

Performance 12 ppm

- Principle of operation

finished page Laser

the roller is heated to
fasten

\
6

tOnEl’ container

\‘\\\ paper
pressure roller \\\§:.
-
rotary drum

39



Lecture Ne 3. Information Technology Software. Windows operating system. General
principles. Standard and utility programs. Word 2010 text editor. Excel spreadsheets

53 PC

* acomputer is a software-controlled electronic

system for working with information;
« apersonal computer (PC) differs from a computer

only in the degree of versatility of the two compo-
nents of a PC: hardware and software;

+ due to its universality (simplification), a PC us-
er (person) combines in his person the func-
tions of an electronic engineer, programmer

and the user itself.

The PC user must understand the purpose,
classification and features of the software.

- User and PC Communication

USER Personal

Computer

Softwarc%

Basic software concepts

6) Algorithm;

Program.




i

)

Algorithm

An algorithm is an accurate and trouble-free
prescription of the actions that must be performed.

Algorithm Properties:
discreteness - the algorithm is divided into individual
elementary steps;

certainty - each team uniquely determines the action
of the performer;

finiteness (effectiveness) - the algorithm must be
completed in a finite number of steps;

directions are provided for all possible scenarios.

4
<P Methods for specifying
' algorithms

in the form of flowcharts;
using natural language;
any conventional signs;
but if we want the algorithm to be exe-
cuted by a computer, it must be writ-
ten in a special formalized language -
a programming language.

5

Programming languages

Depending on the level of detail of the prescriptions, the
level of the programming language is usually determined
« the less detailed the level of language. The following
levels of programming languages are distinguished:

machine;

machine-oriented;

machine independent (high level languages).




Programming languages

High level programming languages.

Writing an algorithm in such alanguage is a
sequence of commands denoted by natural
language words or their abbreviations. Each
of them corresponds to a sequence of
dozens, or even hundreds of machine
instructions. As aresult, the recording is more
compact and understandable to humans.

Programming languages

High-level programming languages are divided into:

procedural (algorithmic) (Basic, Pascal, Fortran, etc.), which are
intended for an unambiguous description of the algorithms; to solve
a problem, procedural languages require in one form or another to
explicitly record the procedure for solving it;

logical (Prolog, Lisp, etc.), which are focused not on the development
of an algorithm for solving the problem, but on a systematic and
formalized description of the problem so that the solution follows
from the compiled description;

object-oriented (Object Pascal, C ++, Java, etc.), which are based
on the concept of an object that combines data and actions on
them. A description of reality in the form of a system of interacting
objects is more natural than in the form of interacting procedures.

Program

« writing an algorithm using a programming language is
called a program (program listing).

« However, the program also means the end result in the
form of machine code. This result is recorded as a pro-
gram file with the extension .exe, .com, .sys.

algorithm listing program program file

Program ex;
Y

& n, Scinteger;
Begin

Writein Bostume n)

ReadLnfn);

S:0,
Joric=1 o ndo

S

Writeln{ Cywa . m, " vaces powwa ', 5);
d




How a machine understands
commands

calculus systems: binary and others;

for technical reasons, binary coding is the "native language" of computers;
any decimal number is represented by a binary number. For example,
the number 13 has the form: 1101;

when encoding text for each of its characters is allocated, usually by
byte. This allows you to use 28 = 256 different characters. In practice,
you must be able to read text created on another computer on one
computer. Therefore, encoding tables are standardized.

enerated i Ises with information

Geperated impulses withol

Voltage

Time
Time

10

For the Russian language, five
encoding tables are used:

CP866 (DOS-alternative) - on PC-compatible com-
puters when working with DOS and OS / 2 operat-
ing systems;

CP1251 (Windows encoding) - on PC-compatible
when working under Windows;

KOI-8r is the oldest encoding so far used. Used
on computers running UNIX, it is the de facto
standard for Russian texts on the Internet.
Macintosh Cyrillic - as the name implies, is designed
to work with all Cyrillic languages on Macs.
1SO-8859. This encoding was conceived as an in-
ternational standard for Cyrillic texts.

11

Code tables

12



“ Sound and Image Encoding

*Sound vibrations, a video image, a graphic im-
age are also encoded in the form of portions of
voltage pulses carrying information in a binary
extinction system.

13

Software Classification

The set of programs and data intended for their processing is
called PC software.

9
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<. Software Classification
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Software

Software Classification

System
software

Programming
systems

Unique
software

18




System software

System
software

| Operating
Systems

M m Arcmve’s ! M M
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No)
N # .
Operating system
+ The operating system is the most important part of computer
software designed to automate the planning and organization of
the process of processing programs, input-output and data man-
agement, resource allocation, preparation and debugging of pro-
grams, and other auxiliary maintenance operations
« The operating system is a software extension of the com-
puter control device
« The operating system is usually stored in the external
memory of the computer - on disk (HD). When you turn on the
computer, it is read from disk memory and placed in RAM.
« This process is called booting the operating system.

4 054
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Operating system features

211 dialogue with the user;

212 input-output and data management;

213 planning and organizing the process of processing programs|

214 distribution of resources (RAM and cache, pro-
cessor, external devices);

215 running programs for execution;

216 all kinds of auxiliary maintenance operations;

217 information transfer between various internal devices;

218 software support for peripheral devices (display,
keyboard, disk drives, printer, etc.);

219 network connection support.

21




2 Types of Operating Systems

The first successful operating system is UNIX (1969). It still
remains one of the main systems on computers that are more
powerful than personal ones and many UNIX-like operating
systems are generated from it.

In 1981, IBM released a personal computer (IBM PC), whose
architecture has become the standard in the world. All per-
sonal computers are usually divided into IBM-compatible (the
absolute majority) and IBM-incompatible, for example, a Mac-
intosh computer manufactured by Apple. Macintosh
computers are running the MacOS operating system.

In 1982, Microsoft released the MS-DOS (Disc Operating System)
operating system, which has become the most popular operating
system for IBM-compatible PCs for many years.

In 1985 - the same Microsoft released the first version of Win-
dows, which initially functioned as a DOS application;

22

5 Types of Operating Systems

1991 - the year of birth of the Linux operating system - the main
competitor of Windows, which is becoming more widespread.

In 1995, Microsoft released the Windows-95 operating system,
which is already working independently. The Windows line
has evolved and today is the most common operating system
with the most popular applications. The latest versions of
Windows: Windows-98, Windows-2000, Windows-XP, Win-
dows Vista, Windows 7, Windows 10.

In addition, you can list many names of operating systems
from various manufacturers, for example: Netware (Novell),
0S /2 (IBM), SunOS (Sun Microsystems), Java Desktop Sys-
tem (Sun Microsystems), FreeBSD (one of the open source
branches of UNIX) and etc.

23

Utilities

« Important classes of system programs are auxiliary pro-
grams - utilities (lat. Utilitas - good).

* They either expand and supplement the corresponding capabilities of
the operating system, or solve independent important tasks.

« Some utilities are part of the operating system, and the
other part functions independently of it, i.e. offline

* monitoring, testing, diagnostic programs to verify the correct function-
ing of computer devices and to detect malfunctions during operation;
indicate the cause and place of the malfunction;

« programs for writing to CDs;

« shell programs for managing files;

« and many others.

24



o Drivers

 driver programs that expand the
capabilities of the operating system
to manage /O devices, RAM, etc .;

» with the help of drivers, it is possible to
connect new devices to the computer or
non-standard use of existing ones.

25

Archivers

» packer programs (archivers) that allow re-
cording information on disks more
densely, as well as combine copies of
several files into one archive file;

 archiver programs differ in various de-

grees of compression.
=7 =
v B 0
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Antiviruses

« A computer virus is a specially written small-sized pro-
gram that can "attribute" itself to other programs to
perform any harmful (for you) actions - it corrupts
files, "clogs" RAM, transfers information over the
network, etc. ;

 anti-virus programs are used to pre- ; a ‘:: &
vent infection of PC software with e
computer viruses and to elimi- o Y @ s
nate the consequences of virus % K McMes  Mcrasot
infection. G wen ook g
!’) i A L
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Services

« disk space optimization and quality control programs;
« datarecovery, formatting, data protection programs;

« communication programs that organize the ex-
change of information between computers;

* memory management pro- BB S
grams that provide more 5‘_—%«
flexible use of RAM.

Some of these programs are included in the OS.

28

System Unique
‘ software software

Programming systems

29

Programming systems

A programming system is a system for developing
new programs in a specific programming language
(Basic, Pascal, Fortran, etc.).
Modern programming systems usually provide users with powerful and convenient
software development tools. They include:
« compiler or interpreter;
« integrated development environment;
« tools for creating and editing program texts;
« Extensive libraries of standard programs and functions;
debugging programs, i.e. programs to help find and fix errors in the program;
user-friendly interactive environment;
multi-window mode of operation;
powerful graphic libraries; library utilities
built-in assembler;
built-in help service;
other specific features.

30



i Types of programming systems

« Translator is a translation program. It converts a program writ-
ten in one of the high-level languages into a program consist-
ing of machine instructions.

« Translators are implemented as compilers or interpreters. In terms of
doing the work, the compiler and the interpreter differ significantly.

+ The compiler reads the entire program, makes its translation
and creates a finished version of the program in machine lan-
guage, which is then executed.

« The interpreter translates and executes the program line by line.

« After the program is compiled, neither the source program nor
the compiler is needed anymore. At the same time, the program
processed by the interpreter must be re-translated into machine
language each time the program is launched again.

31
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-+ Software Classification

System ‘ Programmin

Unique
Software Systems Software
) Application
’ Software
R
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Application software

plication software

Graphic editor |

Text editors |

Spreadsheets | [DEIELET |

Integrated Software

E ==

33




&9 Text editor

» A text editor is a program used specifically
for entering and editing text data.

« This data can be a program or some document or a
book. Editable text is displayed on the screen, and
the user can interactively make changes to it.

et

_— —
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Text editor

Text editors can provide a variety of functions, namely:
1. editing lines of text;
2. the ability to use various character fonts;
3. copying and transferring part of the text from one place to another or
from one document to another;
4. contextual search and replacement of parts of text;
5. assignment of arbitrary line spacing;
6. automatic hyphenation of words on a new line;
7. automatic page numbering;
8. processing and numbering of footnotes;
9. alignment of paragraph margins;
10. creating tables and charting;
11. spelling check of words and selection of synonyms;
12. building tables of contents and subject indexes;
13. listing of the prepared text on the printer in the required number of copies, etc.

Types of Text Editors

The possibilities of text editors are varied - from programs designed to
prepare small documents of a simple structure, to programs for typing,
designing and fully preparing for printing books and magazines
(publishing systems).

« The most famous text editor is Microsoft Word.

« Full-featured publishing systems - Microsoft Publisher, Corel
Ventura, and Adobe PageMaker.

« Publishing systems are indispensable for computer typesetting and
graphics. Significantly facilitate the work with multi-page docu-
ments, have the ability to automatically break text into pages, ar-
range page numbers, create headings, etc. Creating layouts for any
publication - from handouts to multi-page books and magazines - is
becoming very simple, even for beginners.

36




Graphic editors

» A graphic editor is a program designed to au-
tomate the processes of building graphic im-
ages on a display screen. Provides the ability
to draw lines, curves, paint areas of the
screen, create labels in different fonts, etc.

37
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S Spreadsheets

« Atable processor (spreadsheets) is a set of interconnected
programs designed to process spreadsheets.

« A spreadsheet is the computer equivalent of a regular table
consisting of rows and graphs at the intersection of which
are cells that contain numerical information, formulas or text.

Databases

A database is one or more data files designed to store, modify and
process large volumes of interconnected information.
In the enterprise database, for example, can be stored:
« all staffing information,
« about patients with healthcare facilities;
« information on material values;
« insurance data;

« information on stocks in pharmacy warehou

« statement data;
« orders and instructions of the directorate, etz

39



T Database Management Systems
(DBMS)

- Database Management System (DBMS) is a
specialized software package designed for
convenient and efficient organization, monitor-
ing and administration of databases.

» As astructural form of a DBMS, any of
the models existing today can be used.
An example of such a model is arela-
tional DBMS or other DBMS.

40

Network software

* Network software is designed to organize the col-
laboration of a group of users on different com-
puters. Allows you to organize a common file
structure, shared databases available to each
member of the group. Provides the ability to send
messages and work on common projects, the abil-
ity to share resources.

41

i Integrated Software

Integrated packages are a set of several
software products integrated into a single
convenient tool. The most developed of
them include a text editor, organizer,
spreadsheet, DBMS, email support tools,
presentation graphics creation program.

42
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<~ Games and other software

» Application software
includes a large class
of various GAMES;

« Among games there
is a classification;

« Computer video game
lovers are gamers.

43
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< Software Classification
Software
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System H Programming [ Appiication l
Software Systems Softwae
. EE
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Unique software

Software that is not used on personal
computers:

» spacecraft control systems,

« computer models of global cata-
clysms, etc.

45




&3 Software Copyright

» Proprietary software is software that is private-
ly owned by authors or copyright holders and
does not meet the criteria for free software.
The copyright holder of proprietary software
reserves the monopoly on its use, copying and
modification, in full or in essential aspects.

Using a license agreement, a legal rela-
tionship is established for the use of
the program.

7 Typical Proprietary Software
" Limitations

» Restriction on commercial use - allows free use for
non-commercial purposes for individuals, medical
and educational institutions, for non-commercial
organizations, etc., however, they require payment
in case of using a software product for profit. Such
software is very popular and widely used, and due
to its free of charge it has good technical support
from specialists who do not need additional train-
ing costs.

47

& Typical Proprietary Software
Limitations

» Distribution restriction - this type of restriction
usually accompanies large software projects
when the copyright holder requires payment for
each copy of the program. Typically, with such a
restriction, software products are used that focus
on a narrow “professional” market segment or
for software that requires a large number of us-
ers. An example is the Adobe CS3 software
package or the Windows XP operating system.
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.~ Typical Proprietary Software
Limitations

Modification restriction - this type of re-
striction is used only in closed source
software packages and may prohibit or
restrict any modification of program code,
disassembly and decompilation.

49
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i Software installation

« after purchasing a software product on a specific
medium, the program is installed on the computer
(the program is read using the Setup.exe file);

« further activate the
program using a code,
an electronic key;

* in case of free
use, activation is
not required.

50




Lecture Ne 4. Local and global information networks. Using information resources of
the Internet to solve various medical problems

%)

Network definition

« A physical network forms when two or more
computers are physically connected.

« To create computer networks, special hardware is
needed - network equipment and special software -

network software.

« If the network has a special computer

dedicated for sharing by network par- P il < T
ticipants, it is called a file server.

’ 3l
Ay g ©
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.=« Network classification

1. By territorial distribution

Loca
LAN - Local Area Network

(MAN - Metropolitan Area Network)

(WAN - Wide Area Network)

)

£

Network classification

2. By information transfer rate

Medium speed
Up to 100 Mbit/sec

The sieed of information transfer on the local network I




ST Network classification

3 By type of network transmission medium

Ly —
- Wireiess

Radio channels Infrared range

ontcoaxiallicable On twisted pair On fiber optic

Network classification

By the method of organizing the
interaction of network

Peer-to-peer | Jr—

« All peer-to-peer computers are peers. Any user on the network can
access data stored on any computer.
In a hierarchical network, when a network is installed, one or several
servers are pre-allocated — computers that control data exchange over
the network and resource allocation. Any computer that has access to
server services is called a network client or workstation.

Network Feature

+ Bandwidth - the maximum amount of da-
ta transmitted by the network per unit of
time. Bandwidth is measured in Mbps.

* Network response time - the time
spent by the software and network
devices on preparing for the trans-
mission of information on this chan-
nel. Network response time
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Network topologies

* Network topology refers to the physical
or electrical configuration of a cable
system and network connections.
* network node - a computer, or a net-
work switching device.
* network branch - a path connecting
two adjacent nodes.
« terminal node - a node located at the
end of only one branch..
/51\!
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1. Topology “General (linear)
Bus”

> T T T

In this case, connection and data exchange is carried
out through a common communication channel
called acommon bus.

« Transmitted information may be spread in both directions.

:; -._11)

2. Topology “Star”

In this case, each computer is connected by a separate
cable to acommon device called a hub, which is located
in the center of the network.
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& 3. Topology “Ring”

In networks with aring topology, data in the network is
transmitted sequentially from one station to another
along the ring, usually in one direction

10

4. Cellular topology

’ work
station statien

work work
station station

A mesh topology is characterized by a computer
connection scheme in which physical communication lines
are installed with all nearby computers.

11

5. Mixed topology

+ Mixed topology - the net- L) ®
work topology prevailing in .
large networks with arbi- ®
trary connections between 3
computers.

« In such networks, it is possible - —
to distinguish individual arbi- L L @
trarily connected fragments ® —
(subnets) having a typical to-
pology, therefore they are
called networks with a mixed
topology. [} =]
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= Network architecture

* To ensure the necessary compatibility at each of the
seven possible levels of computer network architec-
ture, special standards or rules called protocols are
applied. They determine the nature of the hardware in-
teraction of network components (hardware protocols)
and the nature of the interaction of programs and data
(software protocols).

» Physically, protocol support functions are per-
formed by hardware devices (interfaces) and soft-
ware (protocol support programs). Programs that
support protocols are also called protocols.

POP3, TCP/IP, PPP (Network protocol), PPPoE, DNS, Ethernet.

13
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i Network equipment

The main components of the network are
workstations, servers, transmission media
(cables) and network equipment.
Workstations are network com-
puters where network users im-
plement application tasks.

Network servers are hardware and soft-
ware systems that perform the functions
of controlling the distribution of network 3
shared resources. A server can be any

computer connected to the network on n l
which the resources used by other devic-

es on the local network are located. e

14

1. Twisted pair

S

Coaxial cable

« Fiber optic cable

15



% Types of network equipment

1. Network cards

2. Terminators

16

% Types of network equipment |

I
+ Communicators (Switch) '.‘

17

% Types of network equipment

* Router

« Bridge

18




Types of network equipment

Gateway

* Firewall

19

Global network

1) The Internetis a worldwide system of integrated
computer networks for storing and transmitting in-
formation. Built on the basis of the TCP / IP proto-
cols.

2) eInternet information resources - this is the totality of
information technologies and databases available
with the help of these technologies and existing in
constant updating mode. To their number:

Email,
Database WWW,
Search engines.

WWW — abbreviation «World Wide Web»

20

Domain Name Registration

WWW-server uses hypertext technology. To record documents in hyper-
text, a special, but very simple HTML language (Hypertext Markup Lan-
guage) is used, which allows you to control fonts, indents, insert color il-
lustrations, supports sound and animation output.

Internet domains vary in hierarchy levels.

Top-level domains classify organiza-
tions by type:
gov (government),
edu (educational),
org (organization),
net (main network support cen-
ters), mil (military groups), int
(international),
com (commercial),
<country code> (any country, geograph-
ical point).

21




Internet Protocols

« HTTP (from the English. Hypertext Transfer Proto-
col - "Hypertext Transfer Protocol") - one of the
most common network protocols of the Internet,
the basis of WWW. HTTP is used to transmit infor-
mation in various formats, in different languages
and with a different set of characters.

FTP (from the English. File Transfer Protocol - "file
transfer protocol") - a network protocol designed to
transfer files to computer networks. FTP allows you to
connect to FTP servers, view directories, and upload
files from or to a server. The protocol was developed in
1971 and it is one of the oldest protocols.

22

G2 Internet Protocols
23

= Internet Protocols

e e (o Qi (e e ) cunen e (om0 @ e oo . Clrngrn. § WEECTO MG,
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Internet Protocols

* SMTPis used to send mail from users to serv-
ers and between servers for further forwarding
to the recipient. Data is transmitted using TCP,
using ports 25 or 587. SMTP was widely used in
the early 1980s.

» POP3 (from the English Post Office Protocol
Version 3 - Post Office Protocol version 3) is a
network protocol used to deliver e-mail messag-
es to recipients on TCP / IP networks. Common-
ly used in conjunction with the SMTP protocol.
By default, uses TCP port 110.

25

Browsers

To view the information received from the web
server, a special program is used on the client
computer - a web browser.

The main function of a web browser is displaying hyper-
text. Hypertext is text marked up with the HTML hypertext
markup language, after HTML markup the resulting hy-
pertext is placed in a file, such an HTML file is the most
widespread resource on the World Wide Web.

After the HTML file is available to the web server, it is called
the “web page”. A set of web pages forms a website. Hyper-
links are added to the hypertext of web pages

26

Internet addressing
Two formats:
IP — Address (digital)
DNS — Address (domain)

l l

192. 45. 9, 20 www.ksma.ru
Network I/ \
address Subnet Computer
address address

27




Lecture Ne 5. Computer-mediated systems in medicine. Ways and means of informatiza-
tion in medicine and Health care

Data

> In a broad sense data represents facts,
texts, schedules, pictures, sounds, ana-

logue or digital video-segments.
- Data can be received from result of measuring,

experiments, arithmetic and logical operations .

0

Data should be presented in a form suitable
for storage, transfer and processing.

Measurement

3.Measurement is a process of attribution
numbers for characteristics of explored

objects according to a certain rule.
4.Scale is arule which in accordance with

the objects are being given numbers.

i Scales

There are 5 types of the scales of the
measurement :

* nominal,
+ ordinal,

* interval,

* ratio,
» dichotomous.




Nominal scale

Nominal scale is a scale which includes only
categories; its data cannot be streamlined, no
arithmetical operations can be performed on the
data.

Assessed indicator : Punctuality
[ S T S TR S TR SN N S
I T

Extremely Low Normal
Lowr

High

1
Extremely
High

Pic. 7. 4.Example of nominal scale

)

Ordinal scale

Ordinal scale is a scale that uses labels to
classify cases (measurements) into ordered
classes; to designation numbers for object to
mean the relative object position, but not for
difference between it.

M=102
2.4
54 e 78 00 102 114 128 13BE0

T ETR T u?u 18-20
elrfols

Tac 8e - G5e s1e 71 85 2o
The disign of dart factor N16 -factorl
questionnarie.By R.B. Kettel

From the bottom- intervalsin unit 1/2 of standart deviation.

Pic 6.2

Interval scale

Interval scale is a scale whose differences
between values can be calculated, but their
relationship makes no sense.

9,
Q

-AQ -AQ 0 +AQ +*AQ AQ

Pic.2. Interval scale for 5 sizes




Ratio scale

Ratio scale is a scale which has a definite
point of reference and in which the attitude

between scale values are possible.

3 -2 -1 ] +1 +2

L ! 1 1 — P I
Absolutely Dont know Absolutely
NO YES

Dichotomous scale

Dichotomous scale is a scale which has
only two categories.

= Before experiment

B After experiment

;:y "‘1’}

Table data

Table data is data which is composed of

entries each of which consists of a fixed set
of attribute.

Tabular data organization

"Toys" - B
Name | Material | Color |Quantity|

| balls wood |__red | 75

| cubes | wood blue 20

| dolls | plastic

green 34
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Database

3

Database is data which is well-organized
and electronically stored.

=] [ Book number

10

<P

i DBMS

Database Management System is a software
for creating database, storing and searching for
the necessary information.

Possibilities o
DBMS
Creation of
.| Data sorting
-
Search for
Filling databases Inme gl for mation in the
)
Database edit
— 7"

he installation of

11

DBMS

Database Management System

Programme envelopes

v v v
( Main functions ) ( Database model ) [Typesolllnlmges ]

[“Storageand |
of
structural Relational database '
ipomation ierarchical databas
L_presentation (data) |
Network database

stored view to attributes of the
structural same object

information on some
request

Relationship
between objects

Relationship
between

Conversion of

12




o Relational database

In relational model of data any representing
of terms is confined to a totality of relational
tables (two-dimensional specific type table).
Relational database management systems
are used for construction of data warehouses.

13

Main components of relational
attitude

Data types

whole
number name Domain
Personal | Name Attilb
number ttributes

2934 Ivanov

2935 Petrov Tuples

2936 Sidorov

I

Key

14

Hierarchical database

(@ Patio cTon
& 1L Mo aokyrenmel

1. Hierarchical database can be graphically presented

like a tree composed of the different-level objects. S p——
The top level is occupied by one object, the second i
is occupied by objects of the second level and etc. = ‘;:"r'i;;
5 <o b (€1
# b CD-RW avcrosoa (F:)
2. These objects are in relation to the ances- g < .
tor (object, which more close to root) to the 5 J:’:‘;’“ﬁ'
; 3 Hatfix
descendant (lower-level object). 3 WET Fromework
3. There is possibility that object-ancestor does not jw
have descendants or has more than one, while ob- a J“J"‘*D;'Z';“\“
ject-descendant may have only one ancestor. ¥ (2 1366
. N + SUPPORT
4. Objects which have a common ancestor 5 O vaewo
. # (L) xomnesoTep npect
are named twins. Ly i

& @ bome2(1)
# = Cuorrmai anox (30

Sy p—
R —
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o Network database

The network database is formed by generalization of
the hierarchical database due to the assumption of
objects having more than one ancestor, i.e. each el-
ement of the higher level can be associated simul-
taneously with any elements of the next level.

The network database consists of a series of copies of a
certain types of record and a series of copies of certain
types of connections between this records.

The network database is in fact the
World Wide Web of global computer
network - Internet. Hyperlinks connect
hundreds of millions documents in a
single distributed network database.

16

-+ Methods for processing data

Centralized
Decentralized
Distributed
Integrated

17

"'Centralized data processing

- Implies the presence of a Central computing
object (center);

* The user supplies (transmits) the initial infor-
mation (data) to Computing centre;

* The user receives the re-
sults of processing;

- Difficulty in organization of g

Centralized data processing

, Central ECM

channels of communities;
- Difficulty in organization
of data protection.

' User terminals
) =

18




7
“'Decentralized of data processing

Types of technology

5. Base: PC without networking
6. Base: PC networked without server
7. Base: PC networked with server
in mode «client-server»
D data pi ]

% “.. _ Central ECM

19

S Decentralized data processing

Way of distribution:
» Partitioning an information base into
several physically distributed bases

» Every user uses his database which
is a part of common DB

» Database is installed at several servers

20

-"'Decentralized data processing

Way of duplication:

Complete database is posted at
every server

Synchronization is required for
data harmonization

21
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Distribution of data

Distributed computing

*, Central ECM

22

- The modes of implementing data

distribution

Depend on:

Space-time settings of tasks
Frequency

Dispatch (speed)

Requirement to speed of the processing
Technical capacity

23

Types of modes of data distribution

Batch mode

Real-time mode
Distribution of time mode
Scheduling mode

Query mode

Dialogue mode
Interactive mode
One-program mode
Multi-program mode
Teleprocessing mode

24
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Integrated data processing

It provided for the creation of information
model of the managed object, i.e. the creation
of distributed database;

It allows to improve quality, reliability and speed
of processing since the processing is made on
the basis of data backup which is put into an elec-
tronic computing machine only once;

The peculiarity of this method is the separation
of technologically and time processing proce-
dures from the procedures of collection, prepa-
ration and data entry.

25




Lecture Ne 6. Overview and classification of medical information system. Information
security in a health system

Information systems in

medicine

« In modern health care different technical means of information pro-
cessing find application, beginning from the simplest maps with
edge perforation and finishing the most perfect computers.

« Evolution of process of implementation in medicine and health care
of computers, means of communication and the organizational

equipment naturally leads to transition from incidental use of sepa-
rate devices to full informatization of worker process.
« The different systems integrating technical means, mathemat-

ical methods and programs are created.
» They provide a necessary order of interaction at a solution of
specific objectives of both medical, and technical character.

S Definition

* The medical information system is the form of the
organization of activity in medicine and health care

integrating physicians, mathematicians, engineers,
technicians with a complex of technical means and

providing collecting, storage, processing and issue
of information of a different profile in the course of

a solution of certain tasks.

(¥/\
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Purpose of MIS

The modern concept of medical information systems assumes
association of the existing information resources on the following

main groups:
« electronic stories of patients;
« results of laboratory diagnostic testings;

« financial and economic information;
« databases on medicines;

- databases of material resources; =
+ databases of work forces;
« expert systems;

« standards of diagnostics and treat-
ment of patients, etc.




< History of implementation of Information
systems in medicine

» One of the first systems "Automation of Accounting of Data on
Incidence with Temporary Disability" began to function in 1975
in Medical and sanitary service of Oktyabrskaya Railway.

« In the early seventies abroad the information systems capable to
solve the most various problems began to be implemented.
Among them there is an information system of university clinic
in the Tubing (Germany). It provides medical personnel with
convenient access to the most necessary state-of-health data of
patients and their treatment, carries out preparation of basic data
for diagnostics process programming.

*In 1987 in a health care system of the Russian Federation 18
data processing centers and 40 departments of ACS worked.

4

Classification of MIS by functional
criterion

« The medico-technological IS intended for infor-
mation support of processes of diagnostics, treat-
ment, rehabilitation and prevention of patients in
treatment and prevention facilities.

* The directory systems supporting banks of
medical information for information service
of medical institutions and services of man-
agement of health care.

« Statistical IS of governing bodies of health care.

* Theresearch IS intended for information sup-
port of medical researches at clinical research
institutes.

-~ short classification of the IS

Directory system

Medical information|
system

Datalogical Management
system system




Directory system

* The largest, it is capable, except quick search of the
necessary information in databanks, to carry out al-
so its various conversions.

P | e | T ] =]

Purpose of medical directory
systems

* They are capable to store in memory of "machine" of the
clinical record, different data of bibliographic character,
materials of annual, monthly and daily reports.

* There are systems with databanks about results of the
conducted pilot and clinical trials, information of adminis-
trative and managerial character. These are data on diag-
nostics, duration of treatment and outcomes of a disease, a
status of dispensary observation, etc. And the computer
can provide with the necessary information not only the

attending physician, but also organizers of health care of
all service.

Datalogical system

« Its essential difference — ability to transform information
which is in computer memory.

« And, such systems are capable to generate the new infor-
mation which before was absent in information array.

« For this reason they will be able to be applied to diagnostics,
forecasting and tracking different parameters of an organism.




)

i Management system

« Are known as managing or automated.

« All information which is processed in any of such sys-
tems will be organized in files.

« It is so accepted to call a data set.

10

. Classification of MIS by structural
" technologically criterion

1.The automated jobs and the IS of structural divisions of
medical institutions (medical department, clinical laboratory,
drugstore, etc.) — the first level or basic;

2.The IS of healthcare institutions (policlinics, a hospital, the
diagnostic center and so forth) —the second level;

3.The IS of territorial level (managements of health care,
territorial fund of the obligatory medical insurance (OMI), etc.)
—the third level;

4.The IS of federal level (The Ministries of Health of the
Russian Federation, the federal centers, etc.) — the fourth
level.

11

The first level

Main objective — computer support of work of doctors of different
specialties.

On solvable tasks select :

« directory systems (are intended for search and issue of medical
information on a request);

« consulting and diagnostic systems (for diagnostics of pathological
statuses, including the forecast and development of recommenda-
tions about ways of treatment);

« Instrument computer systems (for the information support and/or
automation of diagnostic and medical process which are carried out
at direct contact with the patient's organism);

« the automated jobs (AJ) of specialists (for automation of all techno-
logical process of the doctor of the corresponding specialty and
providing information support at acceptance of diagnostic and tacti-
cal medical solutions).

12




The second level

Itis presented by the following main groups:

3) information systems of the advisory centers (information
support of doctors at consultation);

4) banks of information of health services (contain summarized
data about the qualitative and quantitative list of employees of
institution, the attached population);

5) the personified registers (containing information on the at-
tached or observed contingent);

6) screening systems (for performing pre-medical routine in-
spection of the population);

7) information systems of treatment and prevention
facility (association of all information flows in a sin-
gle system and automation of establishment);

8) information systems of scientific research institute and
medical schools.

13

The third level

Are presented :
IS of territorial authority of health care;

The IS for a solution of medico-technological
tasks providing with information support activity
of health workers of specialized health services;

The computer telecommunication medical
networks providing creation of a common
information space at the level of the region.

14

The fourth level

Itis intended for information support of the state level of a health care system. At the federal

level creation of management medical systems allows to solve the problems providing the

strategic level of management:

+ monitoring of implementation of the program of the state guarantees of ren-
dering to citizens of the Russian Federation of free medical care;

+ monitoring of implementation of the national Health project and monitoring of overall

performance of public authorities (State automated system "Management");

social and hygienic monitoring;

« monitoring of health of the population of Russia (the analysis of dynamics of the state of
health of the population in connection with social and economic and ecological factors);

« maintaining state registers (register of preferential categories of citizens of the
Pension Fund of the Russian Federation and so forth);

« management of medical educational institutions, movement and retraining of
medical frames;

« accounting and analysis of material, financial resources of health care, etc.

15




Federal standard medical information system

Consultation of the specialist of
| the regional level
-

> Out-patient
District doctor treat_m_en_t
Rehabilitation
General Sanatorium
treatment

Y

Laboratory Specialist
diagnostics doctor

P unﬂ ——

specialist region J oSBLzEton

| level _r____ahospital

S |

Anamnesis of a disease |
Clinical record “l

Federal target program "Electronic Russia"

epicrisis
T T

Diary of the doctor

Survey by the doctor of
department
Objective data
Leaf of assignments

16

S Subjects of information exchange

»

. & d s

executive Medical schools ~ Patients
Federal and scientific
information| in research
| resource | field of health institute
(analysis care
information) |
oo
&
Regional informationt
resource
(consolidation cutive  Medical educational  Patients
information) nstitutio
atives in .
i heath  scientific research
nstitute

care

/' standard integration gateway |
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tem (collecting primary
information)

Patients
treatment and crews institutions

prevention
facilities
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Medical instrument and
computer systems

« Important kind of specialized medical information systems
are the medical instrument and computer systems (MICS).
* MPKS belong to medical information systems of basic level.

The main difference of systems of
this class —work in the conditions
of direct contact with an object of a
research and in areal mode of time.

18




Medical instrument computer
systems

Typical representatives of MICS are medical monitoring
systems behind a status of patients:

when carrying out difficult operatio
systems of computer data analysis of
a tomography, ultrasonic diagnos-
tics, radiography;

the systems of the automated data
analysis of microbiological and
virologic researches, the analysis

of cages and tissues of the person.

19

Medical instrument computer
systems
In MICS it is possible to select three main
components:
medical,
hardware,
software.
20

Medical support

« Includes ways of implementation of the selected circle
of the medical tasks solved according to opportunities

of hardware and program parts of a system.

« Sets of the used techniques, the measured physi-
ological parameters and methods of their meas-
urement, definition of ways and admissible bor-
ders of impact of a system on the patient belong
to medical support.

21




Hardware

*Includes ways of implementation of a technical part of the
system including means of obtaining medicobiological
information, means of implementation of medical influ-

ences and computer aids.

22

Software

These are mathematical methods of processing of medi-
cobiological information, algorithms and actually the pro-

grams implementing functioning of all system.

23

Medical diagnostics

The task of diagnostics in the field of medicine can be set as find-
ing of dependence between symptoms and the diagnosis.

For implementation of an effective organizational and
technical diagnostic system it is necessary to use meth-
ods of artificial intelligence.

The expediency of such approach confirms data analysis,
used at medical diagnostics which shows that they have a
number of features, such as qualitative nature of infor-
mation, existence of admissions of data.

Interpretation of the medical data obtained as a re-

sult of diagnostics and treatment to become one of

the serious directions of neural networks.

24




Systems for carrying out monitoring

The problem of operational assessment of a status of the
patient arises in a number of very important practical di-
rections in medicine and first of all at continuous observa-
tion of the patient in chambers of intensive therapy, opera-
tional and postoperative departments.

In this case it is required to provide on the basis of the long and
continuous analysis of large volume of the data characterizing
a status of physiological systems of an organism not only op-
erational diagnostics of complications at treatment, but also
forecasting the patient's status and also to define optimum cor-
rection of the arising violations.

25

¥
=i Systems for carrying out monitoring

Are among the parameters which are most often used when
monitoring:

« electrocardiogram,

blood pressure in different points,

breath frequency,

temperature curve,
content of gases of blood,
minute volume of blood circulation,

content of gases in an expiratory air.

Important feature of monitor systems is existence of means
of the express analysis and visualization of their results in
real time. It allows to display on the monitor screen also

dynamics different derivative of controlled values.

26

Management systems medical process

Here automated systems of intensive therapy and also

the prostheses and artificial organs created on the

basis of microprocessor technology belong.

In management systems medical process tasks come

out on top:

+ exact dosing of quantitative operation parameters,

+ stable deduction of their preset values in the
conditions of variability of physiological
characteristics of an organism of the patient.

27




P .
«u» Management systems medical process

Understand the systems intended for state management of an
organism in the medical purposes as automated systems of intensive
therapy and also for its normalization, recovery of natural functions of

bodies of the sick person, their maintenance within norm.

28

Medical information systems in
Russia

« Now informatizations of health care as to the most important direc-
tion of modernization and increase in management efficiency and
quality of medical care, the closest attention —is paid and not only
from a practical link and science, but also from the state.

« As the main part of informatization the project of creation of
the uniform state information system (USIS) which is in fact the
first large-scale experience of the state in the field of informati-
zation of medicine acts in recent years.

*To this project the medical information systems (MIS) had
somewhat exotic character. Only the few treatment and pre-
vention facilities paid to automation a close attention.

29




Lecture Ne 7. Modeling of physiological processes and it’s use in practical medicine

ped 2]

Model

A model is an object or information

representation that reflects the essential
features of a real object or process

The requirements for models

0

The following requirements should apply to models:
« adequacy is the correspondence of the model to the original
real system and taking into account, first of all, the most im-

portant qualities, connections and characteristics;
eaccuracy is the degree of coincidence of the results ob-

tained in the process of modeling with pre-set, desired;
« universality is the applicability of the model to the analysis of a num-

ber of similar systems in one or more modes of functioning;
e appropriate cost-effectiveness is the accuracy of the re-

sults obtained and the generality of the solution of the
problem should be tied to the cost of modeling.

-5 Classification of models

Signs of model classifications:

* by areaof use;

* by time factor;

* by branch of knowledge;

* by presentation form.




<. Classification of models

Signs of model classifications by area of use:

« training models are used in training;

« experienced are reduced or enlarged copies of the designed
object. Used to study and predict its future characteristics;

« scientific and technical are created to study processes
and phenomena;

* gaming is arehearsal of the behavior of the object in dif-
ferent conditions;

« simulation is areflection of reality to one degree or
another (this is atrial and error method).

Classification of models

Signs of model classifications by time factor:

« Static models are models that describe the state of the system
at a certain point in time (a one-time slice of information on this
object). Examples of models: classification of animals ...., the
structure of molecules, a list of planted trees, a report on the
examination of the condition of the teeth in the school, etc.

« Dynamic models are models that describe the processes
of change and development of the system (changes in the
object over time). Examples: a description of the move-
ment of bodies, the development of organisms, the pro-
cess of chemical reactions.

Classification of models

Signs of model classifications by branch of knowledge -

is a classification by branch of human activity:
mathematical,

biological,

chemical,

social,

economic,

historical and so on.




Classification of models

Signs of model classifications by presentation form:

« Material models are subject (physical) models. They reflect the external
property and internal structure of the source objects, the essence of
the processes and phenomena of the original object. Examples: chil-
dren’s toys, human skeleton, stuffed animal, model of the solar system,
school books, physical and chemical experiments.

« Abstract (intangible) models are models that do not have a real
embodiment. Their basis is information. This is a theoretical
method of understanding the environment. On the basis of im-
plementation, they are: mental and verbal; informational.

Mental models are formed in the imagination of a person as aresult of thoughts,
conclusions, sometimes in the form of an image.

Verbal is a mental model expressed in colloquial form.

Used to convey thoughts

Information models are purposefully selected information
about the object, which reflects the most significant proper-
ties of the object for the researcher.

i

Modeling

Modeling is the process of creating a model,
as well as studying the functioning of a
model under different conditions.

Types of modeling

+ Information modeling

« Computer modeling

» Mathematical modeling

« Mathematical and cartographic modeling
* Molecular modeling

« Digital modeling

« Logic modeling

* Pedagogical modeling

« Psychological modeling

« Statistical modeling

+ Structural modeling

« Physical modeling

« Economic and mathematical modeling
+ Simulation modeling
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Process of modeling

The modeling process includes three
elements:

* the subject (researcher),
 the object of study,

» the model that determines (reflects)
the relationship of the knowing subject
and the knowable object.

10
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Modeling background

1. Dimensions
1.1. Mega (Large)
1.2. Micro (Small)
2. Time
2.1. Long
2.2. Moments
3. Security
3.1. For the outside world
3.2. For areal object or phenomenon
4. Learning objectives

11
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Properties

* The essential features of a real ob-
ject or phenomenon

* Time of creation
« Cost

12




Classification of
information models:

13

Tabular model

In a tabular model, alist of similar objects or properties is
placed in the first column (or row) of the table, and the
values of their properties are placed in the next rows (or
columns) of the table.

Date Rainfall Temperature | Pressure( | Humidity
(] mmHg) (percent)
=35 746 67

15.03.97 Snow

16.03.97 No precipitation 0 750 62
17.03.97 Fog 10 740 100
18.03.97 Rain 34 745 96
19.03.97 No precipitation 52 760 87

14

Table of type "Object-property”

14.03 Show -15
15.03 Rain -20

0

One line contains information about one
object or event

15



Table of type "Object-object”

Reflect relationships between objects

16

Table type «Double matrix»

Reflects the qualitative nature of the
relationship between objects

17

L e

" Tabular Information Models

« Static model

The price of individual computer devices (1997)

Device name Price
System board 100
Processor Pentium I (300 MHz) 200
Memory 16 Mb 30
Hard drive 4 Gb 150
Floppy drive 3.5” 20
Videocard 4 Mb 30
Monitor 15” 200
Case 25
Keyboard 10
Computer mouse 5

18




Tabular Information Models

« Dynamic model

The changing of computer’s price

Years

1997 1998 1999

Computer price Pentium Il 1800 1200 800

19

Graph

Graph is a means of visualizing the
composition and structure of the
scheme.

20

)

i Hierarchical model

« Hierarchical model is a system whose elements are
in relation to nesting or subordination.

- In the hierarchical model objects are distributed by
levels, moreover lower level elements enter into one
higher level element.

- Such models are built in the process of classifying objects.

21



...~ Hierarchical informational
models

« Static model

o.%

Computer classification

22

~ : ; i
<.~ Hierarchical information models

* Dynamic model

Genealogical tree of Rurik (X-XI centuries)

23

P 4 .
<.~ Network information models

Network model is graph, in which apexes
connected according to principle “Lots to lots”.

- Ié?fy ﬁc&@,
HOR e

Pic. 5.4 Network structure of global internet.

24
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% o . . .
<.~ Semantic information model

Semantic model is graph, which
based on the concept that all
knowledge could be presented as
complex of objects (concept) and
connections (relations) between them.

25

7 . .
<. Semantic information model

«Once in cold winter time | came out from
the forest»

- Who?
Y / :
-
Which? \.

26

)

Verbal model

As example may be introduced such literature genre as fa-
ble, because real relations between people transfers to rela-
tions between animals or fictional characters.

Actually, any literature work may be
considered as a model. So in the novel
of Leo Tolstoy “War and Peace” you
can find a verbal description of the Bo-
rodino battle. Moreover, the author de-
scribes both the dynamics of events
and the costumes of the characters.

27




Graphical model

A picture, painted by artist, and a scheme from
textbook are graphical models of the same object.

[hBorodino
The 26 of August, 1812
Watercolor of unknown artist. The 1°*
quater of XIX.

28

Mathematic models

. Solving problems in physics, you cre-
ate mathematical models of various
phenomena and processes.

Mathematical models are models built with
using mathematical concepts and formulas.
For example, a model of uniformly
accelerated rectilinear motion:

2
S=vp*t+(@a*t )2
« S —way, that body has passed in time
t; a— accelerate;
vo — initial speed;

29

Computer modeling

* In computer science, models that can be created
and explored using a computer are considered. In
this case, the models are divided into computer
and non-computer.

« Currently, there are two types of computer models:
structural and functional, which are a
conditional image of an object described
using computer technology;
imitation, representing a program or a set
of programs that allows to reproduce the
processes of functioning of the object in
different conditions.

30



Lecture Ne 8. Typical tasks of Informatization of medical technological process in medi-
cal-prophylactic institution

Creation of a unified information system of account-

ing of insured persons in the CHI system Development
The establishment of a secure data network in 2009 of the
Creation of a unified national system of electron- d
The concept of long-term ic medical records concept an
socio-economic development Formation of the unified register of medical personnel the system
of the Russian Federation Formation of the national electronic medical library ji
until 2020 (government order RSIECtch
of 17.11.2008) creation of
information
Stimulation of application of information and .
by and system in
citizens health care

Strategy of development of infor-

Integration of state information systems and re-
mation society in the Russian

sources, ensuring effective interdepartmental and

Federation (government decree of
7.02. 2008) N PR-212

interregional information exchange
Increasing the volume and quality of public services

provided to organizations and citizens in electronic Testing of the
form basic
functionality of
To approve a set of measures to create a state the system at
Order of the President of the information system of of the pilot sit
Russian Federation following the medical care EIRLDISTES
meeting of the Presidium of the in 2010

State Council of the Russian

Federation on July 17, 2008

5.The Ministry of health and social development of the
Russian Federation is to allocate in 2010 from the

e Federal law dat Federal budget funds for the creation of an infor- Phased
02.12.2009 No. 308-F2"On the '\  Mation system in health care in the amount of 239 " .
Federal budget for 2010 and 570.8 thousand rubles implementation
the planning period of 2011 of the concept
gdiznizy (2011-2020)

Stages of creation of information system in
health care of the Russian Federation

2009 year. 2010 year. 2011 - 2012 years.
[ *Introduction of electronic medical

*Development of
card of the citizen

standard solutions!
[*Creation of the

*A draft of participants of I o mation *Launch of service of electronic
concept of the health care system [ e record to the doctor in all subjects
system has (health facilities, of the Russian Federation

o
ey SMO, TFOMS, Jaie  cation of * The organization of interregional
developed Istandard solutions

FFOMS, health lof health facilities, mutual settlements on CHI on the

jiDeveloped by management body {TFOMS, ouz basis of the uniform automated

FeO of the subject of | system of standard reference

“Developed the Russian [ matenclgl information Introduction of a single

lunified information

projects TK to. Federation) lexchange network CHI policy

Create alad eApprobation of | |sGeneral stimulatio *Monitoring the volume and quality

the system standard solutions | [of it implementation, of medical services provided
on the basis of in medical *Transition to continuous
Federal medical organizations monitoring in the collection of
institutions medical statistics

ot y ’
r’ourg‘lelstm 239‘7:‘”“0" 479,4 billion
Federal budget roubles. roubles
B chibudger 24billion roubles.

2

- Scheme of organization of information
' flows

Federal le

Electronic
medical card of a
citizen

L

Medical passport

ect of the Russian Feder:

i

Medical staff




Introduction of modern information systems in
healthcare

Objective Improving the efficiency of the organization
and management of the process of providing
medical care to the population

TASK I:'> Ensuring effective information support of

bodies and organizations of the state and
municipal health systems

ACTIVITY [, =t Uniform CHI policy, including as part of the universal

card of the citizen of the Russian Federation

ion of systems Ol
of information exchange between subjects of the CHI
system
Informati of medical i

document management)

Organization of provision of medical services to
citizens using a universal electronic card

Regional activities of the implementation plan of the
information society development Strategy in Russia

p. 3. Use of information and communication technologies in health and
social protectionTii

« Development of information technology infrastructure of
health care institutions

« Providing access to the Internet for medical institutions

« Ensuring the availability of information on the activities of medical
institutions on the Internet

« Implementation of information systems for management of
health care institutions

« Introduction of information systems to support the provision of
medical care in the activities of medical institutions

« Development of information technology infrastructure of the
emergency medical service

« Training of health care workers in the use of information and com-
munication technologies

Regional activities of the implementation plan of the
information society development Strategy in Russia
p. 3. Use of information and communication technologies in health and
social protection

« Development of information technology infrastructure of health
care institutions

Objective: to create a single industry-wide secure information and
telecommunications network in the health sector

Tasks:

+ Connection of healthcare institutions to the departmental network using a standard integra-
tion gateway with the provision of additional telematics services

« Construction/modernization of structured cable networks in
healthcare institutions

* Modernization of computer and office equipment fleet, including

active network equipment, server and communication equipment

« Practical implementation of a set of measures for the protection of pro-
cessed information and information security in health care institutions

6



/ data

: Standby regional data
| synchronization

center MIAC

Regional data center in the health - )
care system 1

inistry of healthcare

medical insusance
organizations W

Pharmacy | -
institution

Territorial Fund of cor
medical insurance

Regional activities of the implementation plan of the
information society development Strategy in Russia

p. 3. Use of information and communication technologies in health and
social protection

» Implementation of information systems for the management of
health care institutions

Obiective: to Improve the efficiency of management of medical institutions through the

use of information and communication technologies

Tasks:
Reduction of patient waiting time to the doctor due to the use of auto-
mated information systems in the register of health care institutions
2. Optimization of routing of flows of patients in need of medical care at various stages of its

provision through the introduction of automated control systems

3. Modernization of information systems for comprehensive analysis of
health status and health system activities at the level of health institutions
/ municipal districts and urban districts / region

4. Modernization of management information systems for the implemen-
tation of a single program

5. Introduction of electronic document management in healthcare institutions

Electronic routing

Recording on

reception to

care physicial [
s

Consultation Spitalization

ik

Municipal and régional health
facilities

for admission, consultation,

clinical level and the provision of
VMP

Coordination of the consultation date




Regional activities of the implementation plan of the
information society development Strategy in Russia

p. 3. Use of information and communication technologies in health and
social protection

 Introduction of information systems to support the provision of medical
care in the activities of medical institutions

Obijective: to Improve the quality of medical care through the use of information systems in

the activities of health workers, formalization of registration procedures for the volume and

quality of medical services provided to the patient

Tasks:

« Personalized accounting of the volume and quality of medical services provid-
ed to the patient on the basis of electronic medical records

« 2. Automated monitoring of the implementation of standards of medical care

+ 3. Modernization of information systems of management of financial and economic|
activity of medical institutions

* 4. Organization of work on the formation and maintenance of registers of patients
in need of high-tech medical care

+ 5. Organization of remote consultation of patients in clinically complex cases
within the framework of the regional telemedicine system

+ 6. Organization of automated preventive screening in health centers with the for-
mation of an individual health passport

10

T

“u Federal standard medical information system

Consultation of a specialist at the
| regional level
~

Outpatient

Local doctor treatment
General Rehabilitation
practitioner Spatreatment

Laboratory Doctor-

diagnostics expert
——l- epicrisis
Hospitalization ’L‘
» The diary of a doctor

Consultation of a specialist
Examination by the doctor of
The history of the disease || the bepartment
Case histon

| atthe regional level
Objective data

L The list of

11

Technical requirements for a typical medical infor-~

mation system s

Federal law "on technical regulation”.
Federal law of the Russian Federation of December 27, 2002 N 184.
Federal law “on information, Informatization and information protection”. Federal lavi of the

Russian Federation No. 24 of 20 February 1995.

GOST 34.201-89. Information . Asetof for systems. Types, complete-
ness and designation of documents in the creation of automated systems

GOST 34.601-89. Information technology. A set of standards for automated systems. Stages of creation
GOST 34.602-89. Information technology. A set of standards for automated systems. Terms of reference
for the creation of an automated system.
GOST 34.603-92. Information technology. A set of standards for automated systems. Types of
tests of automated systems.

GOST R 52600-2006 Protocols of of patients alities. GOST R 5 Electronic
medical history. Generalities.
GOST RSO / TS 18308-2008 Infor ion of health. Req for the eof

health accounting.

GOST R 52979-2008 Informatization of health. The composition of the data of the consolidated regis-
ter of insured citizens for electronic exchange of these data. General requirements.

GOST R 52977-2008 Infor i of health. C i of data on mutual payments for treated pa-
tients for electronic exchange of these data. General requirements.

GOST R 52978-2008 Informati of health. C ition of data on the health care facility for
electronic exchange of these data. General requirements

GOST R 52976-2008 Infor i of health. C i of primary data of medical statistics of
medical institution for electronic exchange of these data. General requirements

RD 50-34. 698-90. ical instructions. A set of and guidance documents for au-

tomated systems. Requirements for the content of documents

12




¢ Based on the MSI, the following activities should be
automated:

The composition and structure of I1As should reflect the needs of the institution and
allow for future change

13

Levels of Medical information system

+  minimal;

*  basic;

+ advanced.

The minimum level should provide:

*maintaining statistical data for treatment;

«interaction with the registrar of the NSI;

« Interaction with an integrated gateway to transmit and receive
data. The basic level of ensuring the maintenance of all sections
of the EMC. The advanced level additionally includes:

« formalized maintenance of all sections of the EMC;
«interaction with external subsystems (RIS, LIS, ...);

« Interaction with healthcare facilities providing authority;
«interaction with analytical systems and decision support tools.

14

Expanded MSI




accountin,

Outpatient card sections:
card title page;
history;
signal information;

Electronic medical record

GOST R 52636-2006 “Electronic medical history. General Provisions ";
GOST RSO / TC 18308-2008 “Health informatization. Requirements for the architecture of electronic health

GOST RSO/ TO 20514-2009 “Health Informatization. Electronic health records. Definition, scope and context. "

Sections of the medical history:

title page of information security;
signal information;
adoctor’s record in the admission

appeals to specialists; department;

labor loss; inspections;

list of final diagnoses; diagnoses;

diagnostic purposes; diaries;

medical appointments; operational benefits;
Epicrisis; medical appointments;
references; diagnostic purposes;

conclusions of medical commissions; Stay in the departments;
the attending physician;

results of appointments;

information about hospitalization;
information about spa treatment;

vaccination prevention; Epicrisis;
information on dispensary observation; statement;
personal account Notices;

personal account

16
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Types of MSI by Function-
ality

Medical information systems for healthcare facilities
Regional information systems

Administrative and accounting systems
Pharmacy, drug movement

Hardware and firmware, system integration

Mobile, web-applications, telemedicine, cloud services
Non-medical systems, dispatching, monitoring Specialized
solutions for medicine (laboratory, dentistry, surgery, neu-
rology, etc.))Additional functionality and environment for
application development

.

17

Composition of MSI

* The composition of medical infor-
mation systems for each medical or-
ganization may differ in the composi-
tion of the included modules.

* For example: MIS hospitals need modules

18




MSI requirements

» +What modules does your organization need? You can
read about this in the “Guidelines for ensuring the
functionality of medical information systems of medi-
cal organizations” approved by the Ministry of Health
of the Russian Federation.

* You need to familiarize yourself with the "Unified Register

of Russian Programs for Electronic Computing Machines

and Databases", which is located on the website of the Min-
istry of Communications. You have the right to buy IIAs on-
ly from that are included in this registry.

sIMPORTANT! From January 1, 2016, a legislative

ban on foreign goods and work has been in force in

the public procurement system!

19

Examples of MSI
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AZDEC CAITA NABOPATOPHA-ayBaHN D VHUKEEHEI HOMED
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Maintenance and technical support

. Connection to aregional medical corporate network

. Service of computer and office equipment

. Service of local area networks and active
network equipment

. Server service

+  Conducting an information security audit, developing
a package of documents and recommendations for
preparing for certification of personal data information
systems operating in health facilities

Communication services

*Telematic communication services
«Communication services for data transmission

25




Lecture Ne 9. Information Support for Diagnostic and Therapeutic processes. The Use of
Information Technology Systems in the Work of the Medical Department of a Medical
and Preventive Treatment Institution

The Structure of Information Flows in
Healthcare Facilities, Reflected in HIS

-!-

g Patient

Medical
and
leconomic
standards !

[——)

<P .
.g;_;;f__,: Electronic Document Management

Predictive text input with the use of previously entered text
blocks, flexibly customizable automatic text input from already
created documents (results of analyzes, studies, consultations,
etc), title page of a medical record, appointment system, etc

Ability to customize flexibly the
loading of information from devices

Electronic documents with a flexibly customizable
structure related to the subsystem of medical appoint-
ments and the subsystem of accounting for the ser-
vices provided. Ability to enter documents in “block
mode”

The ability to “replicate”
documents, copy content,
printing on laser printers, dot-
matrix printers in "fast mode”

Ability to use standard document
blanks in order to speed up work

-« Integrated Informatization

@ Information Stream Integration

-.' _

Financing Planning
Prevenuon Supply
Smemmc work Dle! food -
Conlrol

o | oo
‘, ‘ Coverage in the system of all aspects of the functioning of the
- institution




,:. : Concentration around the Patient

Passport Information I___Dﬂe_s_uj
5 = Checkups ll
Diagnostic prescriptions

Prescriptions II

Medical prescriptions l. 3. =II
& Medical

Research results
Periodic health I
examinatiol
Transfusion & operatons
1] e

protocols

[ UNIFIED MEDICAL RECORDS |

Support for the Diagnhostic and
Treatment Process

Diagnosis, treatment

«iExamination and treatment:planning
«:Control of the diagnostic process

Hospital «ipata Submission
information «:Health Care Standards
SYSIEM . yalidity of Appointments

Objective data (unified medical r

Accessibility of any APM from any hospital
computer on the one hand

Regulation of access to information and actions
on it by user powers in accordance with official
duties on the other hand




Telemedicine

The MIS architecture in Interin
technology can allow access to patient
data using special APM and remotely
through global networks, in
accordance with the authority and
established regulations.

Thus, a specialist doctor will have
access to all the necessary information
from the patient’s medical record.

Visualization Sheet

Visualization of information from a single patient medical record in accordance
with the requirements of the treatment and diagnostic process and user
authorities
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| Inspection Document with Graphics
The system operates with various types of information, such
as text, graphic, etc.
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Interactive Work with Images

10

? Comprehensive Information
' Analysis
B i
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Analysis of electrocardiographic wave. For clarity, the data can be
represented by various diagrams.
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Integration Capabilities

: T
<::> Third-Party
P Developments

12




Devices Connection

s LLLLLLLLLOS

i = e — i —

ECG result. Charts.
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Medical Functionality

R

It includes all the necessary tools to support the doctor:

« Initial examination of the patien
« Diagnoses.

+ Prescriptions.

« Consultations.

+ Diary entries.

Epicrisis.

Statistical coupon.
Protocols of operations.
Transfusion protocols.
Preoperative concepts.

« Technological instruction.

14

Department Head Functionality

Includes medical functionality, as well as control using custom
collections:

« Various patient lists (depart-
ment patients who drop out
without a diagnosis, etc.).

« List of consultations not
held on time.

« Information about the movement
of patients in the department.

« Medical records of patients of
the department.

15



Functionality of the diagnostician
(laboratory assistant)

Diagnostic-specific functionality:

« List of prescription viewing.

« Execution of prescriptions.

« Appointment of additional stud-
ies to the patient.

« Formation of a motivated refusal in the
performance of a prescription.

« Patient’s medical record viewing.

+ Obtaining a report on the activi-
ties of the doctor (unit) in forms
30 and 39 for the period.

16

« Maintaining a first aid kit

« Patient movement.

« Portion control.

Senior Nurse Functionality

Automated functions of a senior nurse:

unit.

Information about
absenteeism.

17

L)

P Desk Nurse Functionality

Automated functions of a desk nurse:

« List of prescription viewing.
« Temperature sheet
data entering.
« Prescriptions scheduling.
« Prescriptions execution.
« Maintaining a first-aid kit post.
« Prescribing medicines to
the patient.

18




Functionality of Medical Statistics

—E‘runctionalily STatsStTs,

- ¥

1) Statistical coupon control.

2) Obtaining state reporting.

3) Obtaining aregister of
treated patients.

4) Work with reference books.

5) Monitoring the patient’s
processing chain.

6) Data correctness control.

19
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i Pharmacy Functionality

The main task of the subsystem is the comprehensive accounting
and control of the movement of pharmacy materials (goods) in a
medical institution at all levels.

Functionality:
The head of the pharmacy.
Head of the department
of prefabricated forms.
Head prescription and pro-
duction department.
Pharmacist.
Head nurse.
Guard nurse.

20
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e ECG Analysis
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Test Results Viewing

-::—,"__’_‘“""’-"“—3}”"

Result viewing on the desktop |

22

A Digital and Digitized Image Data Archive

23

“Laboratory” Module

allows to automate the workflow between the doctor and the laboratory
serving his areas

The module offers:

a control mechanism for incoming applications, as well as a form
for filling out the results;

work with a barcode referral containing information about the upcoming examination,
the diagnosis of the patient, as well as the referring doctor;

entering the results of analyzes in special forms designed for cer-
tain types of analyzes, with the possibility of manual correction of
the norms of results;

automatic completion of analysis results using automatic analyzers;
printing and saving the results of analyzes in a database with an
indication of indicators whose values do not meet the standards;
informing the doctor about the study.

24




S “Laboratory” Module

provides work with an appointment card barcode
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o “Laboratory” Module

provides entry of analysis results in specialized forms

Commen e Comeu o W Comeenpestn o o s
Bischemical snabisis of beod N 77 .

ndnc bt o i i bt W et

- e s oo
1 st pen { { t et Uesdie Gooie e
Owirie  Coatmeetn G s Ono

26

i “Diagnostics” Module

designed for diagnostic rooms using various medical devices

The module allows to:

« identify the patient in the system by personal card or by direction;

« enter and save research descriptions;

« save (attach to the patient’s electronic map) and work with medical
images obtained in the form of graphic files, as well as using vari-
ous medical imaging devices (ultrasound devices, digital X-ray ma-
chines, X-ray computer tomographs, magnetic resonance tomo-
graphs, positron emission tomographs and other);

« inform the doctor about the study.
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“Diagnostics” Module

allows to fill out research protocols
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S “Diagnostics” Module

allows to attach images to the medical record and work with them

29

& “Statistics” Module

Provides uniform composition and formats of reports;

Includes a formed block of reports on annual reporting forms;

It includes a specially developed designer of new reports, which provides
a solution to the operational tasks of a medical institution, and is also a
mechanism for planning and monitoring medical and business activities;
Provides processing of form 025/Y - Outpatient's coupon;

It makes it possible to work with directories of the Federal
Compulsory Medical Insurance Fund as part of processing files

of the attached population, a list of beneficiaries;

Provides the organization and presentation of information on
settlements between medical institutions, reporting on the na-
tional project “Health” (program of additional medical examina-
tion with the provision of the required registries);

Provides the ability to generate reports on various specialized
programs, including supplementary drug provision.
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Cloud Technologies

Cloud technology is the Cloud technologies
provision of users with
remote access to services,
computing resources and
applications (including op-
erating systems and infra-
structure) via the Internet
through the hosting

sphere. necessary files are always at hand

31

Hosting

a service for the placement of customer equipment on the
territory of the provider with the provision of connecting it
to communication channels with high bandwidth

the need for software and digital services, the hardware
and software of which is located outside the organization
(user) and which could be managed from the inside, but
which would be more economical and efficient

32

<P A - cloud characteristics
b B - cloud models
C - implementation methods

Self service Network access from| Measurability of
Instant elasticlty :
on request different devices service
Multitenant resourse pool

33



Implementation Methods

* private cloud;

* public cloud;

* community cloud;
* hybrid cloud.

o

34
r .
Private Cloud
* acloud developed for use
by a single organization;
* may be owned by this organiza-
tion, or any other.
35
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Public Cloud

¢ a cloud developed for free use by various

users of various companies.

=2
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Community Cloud

. a cloud intended for use by a specific
community of consumers from organizations
that have common tasks (for example, security
requirements);

. the public cloud may be in the cooperative
(joint) ownership, management and operation of
one or more community organizations or a third

party (or any combination thereof).

37
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Hybrid Cloud

here a cloud is a combination of two or
more different cloud infrastructures (pri-
vate, public or public) that remain unique
objects, but interconnected by standard-
ized or private data and application trans-

fer technologies.
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4 Ways to Implement the Cloud

* Private (for onerself)

« Co-public (for the group)

* Public (for all)

* Hybrid (a combination of the 3 above)

39
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Cloud Service Models

3 models of the sale of services:

1. Cloud Software as a service (SaaS)
= Applications as a service

2. Cloud Platform as a Service (PaaS)
s Cloud Platform as a Service

3. Cloud Infrastructure as a Service (IaaS)

e Information infrastructure as a service

41

Cloud Models Graph

Cloud moacls for different user groups

Ultimate
user

Application
developers.

Network architects
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Software as a Service
(SaaS)

The SaaS concept provides the ability to
use software as a service and do it remote-
ly over the Internet.

This approach allows you not to buy a

software product, but simply temporarily

use it when a need arises.

43

T

- Platform as a Service (PaaS)

PaaS can be thought of as a virtual platform,
ready to work, consisting of one or several vir-
tual servers with installed operating systems
and specialized applications.

Most cloud providers offer the user a choice of
masses of ready-to-use cloud environments.

44

Infrastructure as a Service
(laaS)

Infrastructure for rent. The user is provided with a
“clean” copy of the virtual server with a unique IP
address or set of addresses and part of the stor-
age system.

To manage the parameters, start, stop this in-
stance, the provider provides the user with a

program interface (API). n
A
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‘SaaS” "PaaS” “laaS”

Rent Development Migration
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.5 Data Storage as a Service

(dSaaS)

» dSaas - storage as a service - model as a
special case of dSaaS, in which the supplier
provides the customer with storage space.

* In this case, usually the size of the service
payment depends on the maximum storage
volume and access conditions determined
by the channel capacity.
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- The Advantages of Cloud
Computing

« The user pays for the service only when he needs it,
and most importantly, he pays only for what he uses.

» Cloud technology allows you to save on the acquisition,

support, modernization of software and equipment.

Scalability, fault tolerance and security and au-

tomatic allocation and release of necessary re-

sources depending on the needs of the applica-

tion. Maintenance, software updates are

performed by the service provider.

* Remote access to datain the cloud i.e. one can

work from anywhere on the planet where there
is Internet access.

49

The Disadvantages of Cloud
Computing

The user is not the owner and does not have
access to the internal cloud infrastructure. The
safety of user data is highly dependent on the
provider company.

A drawback that is relevant for Russian users: in
order to receive quality services, the user needs
to have reliable and fast access to the Internet.
Not all data can be entrusted to an In-
ternet provider, not only for storage,

but even for processing.

50

The Disadvantages of Cloud
Computing
Not every application allows us to save, for example, on a

flash drive the intermediate stages of information pro-
cessing, as well as the final result of work, and online re-

sults are not always convenient.

« There is a risk that the provider of online services will one

day not make a backup of the data, and they will be lost as
aresult of a server crash.

By entrusting your data to an online service, one lose con-

trol over them and limit the freedom (the User will not be
able to change any part of his information, it will be stored in
conditions not subject to him).
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? The Use of Cloud Technology (in

Education)

l.electronic diaries and magazines, personal
accounts for students and teachers, an in-
teractive reception and more;

2.thematic forums where students can ex-
change information with each other;

3.information search, where students can
solve certain educational problems even in
the absence of a teacher or under his guid-
ance.

52
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Examples:

electronic textbooks;

simulators;

diagnostic, test and training systems;

applied and tool software;

laboratory complexes;

systems based on multimedia technology;
telecommunication systems (e.g. email, newsgroups);
electronic libraries;

etc.

G Future

The proof that cloud technology is not a temporary
hobby, but a new path for the development of high
technology, is the following fact: no matter how
strong the contradictions between the three giants -
Microsoft, Apple, and Google, - almost simultane-
ously they entered this new (so far) territory, and
they’re not going to leave at all.
Moreover, it is with ‘ . l
cloud technologies that s Ny —
all three companies ! ) Wl
connect their future.
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Lecture Ne 10. Automated medical and technological systems of departments of clinical
laboratory research and radiology.
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Clinical Decision Support

System ICU MPI

Targets:

* To improve the quality of medical services, provide effec-
tive decision support and control of the medical staff ac-
tions in surgery and other IT events

« In surgery, the system provides:
> individualization of a patient’s computer mod-
el; interaction with the knowledge base;

> clinical decision support;
> user-friendly graphical interface;

> recording medical staff actions in medical manipulation log
book; easy integration with video and CT control systems.

Intellectual Support of Clinical Medicine
in ICU (ACOPB)

E————

odel and Individualizati

Decision, weak links

Structure and set of laws
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L Information Support
' of the Modern Surgery Block

-~ Modern Types of Control in the
Operating Room

+ Patient control;

* Environmental control;

« Equipment control;

* Video telemetry (including the transmission of
video and audio images);

+ Total recording of information (saving to the
database);

+ Central distributed console;

Medical staff control;

+ Recommendations for managing medical
manipulations (IEM/AWFS).

Clinical Service Virtualization

1.Target is to provide areal-time remote clinical services.
2.CS Virtualization provides:
> Remote application program or algorithm over the
Internet
> Considerable savings compared with the imple-
mentation of own services
> Productive work of a remote application using
parallel and hybrid server technologies
> User-friendly intelligent interface Short-term doc-
tor training




Clinical Service Virtualization
Example

Commercial DPC |
@ - GPU Cluster

Personalized Treatment Software
P

© Internet 1

‘ VPNISLA —

Operating Room
Live Video System

« Tasks and targets are to improve the health care quality and
the interaction efficiency of the medical staff in surgery, as well
as in meetings, board of doctors and staff training (including re-
mote ones).

* Insurgery the system allows:

» to transmit images of the surgical area (including endoscopic sur-
gery) from the operating room in HD quality;

» to transmit background information: sound, text information, te-
lemetry of the patient and the environment;

» simultaneous transmission of audio and video signals between
several participants, including on-line remote consultations of spe-
cialists;

» to provide live video logging for subsequent playback of records.

Surgery Live Video Scheme

Dicters Ofice

‘Operating Room 1

Masting Hall

Videa Panel with Camera

‘Oparasing Rocen 2

i- &

Recording Server

Medical staft Foom




Video Content Package for
Operating Room

10

Live Video Set
in Operating Room__
. )

Medical Information
System

Patient: 01327-002 G (X), 32/65, 12104108, MSC

Surgery process:
Diagnosis: 12201, varicose veins
gnosis: 12201, varicose veins Patient preparation: 12:

Surgical indication: signs of ncreasing lrophic changes in soft tissues [| - Anesthesia: 12:10
on the inner surface of the lower part of the leg, insusceptible to ||~ Beginning of surgery: 13-

medical reatment; of 1220 it o

End of surgery:

The operating team: Operating Room Telemetry
Wvanov L. - Surgeon =16,4C

Petrov P.P. - Assistant AP = 748um
Sokolova 1V, - Anesthetist  H=65%
Dmitrieva AA ~ OP nurse

Telemetry ofthe patient = =

3596 Medical Equipment
Heart rate = 57 BPM B - Cardiac monitor
WBP.Wb- 11255 |

MV, DV = 80, 300 - Anaesthetic workstation.

Meteorological
Station

others.
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Effectiveness of
LVS Implementation

6. Ability of remote surgery process monitoring;
7. Ability of interactive consultation and discussion of surgery;
8. Analysis of staff actions;

9. On-line medical personnel training and with help of
records of surgery conducted;

10. Integration in HIS ICU.

12




Tele- and Video- Monitoring
System

Targets are improving the medical services quality, objective anal-
ysis of disputable situation related to patient treatment.

Tasks:

live video, information recording and storage of the staff ac-
tions and the situation in rooms associated with the conduct of
potentially dangerous manipulations that can cause complica-
tions of patients' conditions;

internal regulations compliance control and treatment regi-
men by patients and visitors;

prompt response by the personnel of the medical institution
in case of emergency in patient's rooms.

13

Scheme of Tele- and Video-
Monitoring System

14

Set of Tele- and Video- Monitoring
System

The system consists of: »

« special design and performance video cam-
eras installed in the patient's, operating, y TQ
treatment and diagnostic rooms;

« monitors for displaying video information at
medical posts in departments;

« hardware-software complex for processing,
storage and playback of video data;

« remote workplaces to monitor the situation

and analyze events.

15




? Video Data Storage and Processing
System

A complex of special-purpose
servers and software that :

receives video, audio and tele-
metric data;

records and backups data;
playbacks records;
- forms user interface of workplaces.

S

16

Effectiveness of
LVS and TMS Implementation

« Reduction of risks arising from potentially dangerous
Diagnostic and Treatment Process (DTP);
Improving the patient service quality;

Upgrade training and responsibility of medical staff,

optimization and improvement of DTP;

Improving patient satisfaction with the quality of medical

care provided.

17

i Medical Staff Monitoring System

* Objective time control provided by medical staff
for each particular patient who is being treated in
MPI;

« Control of patient location in MPI;
« Environmental Monitoring in drug storage facilities;
» Mobile equipment search’rgduction.

= ! 3 g

18




Basic System Component

Wi-Fi Router

RED-Raod

RFID Tag for personnel/patients

RFID Tag for equipment

P :
System Architecture
e~ ; , 88 8
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% The Effect of Application of the
System

« Mobile equipment search reduction

« Personnel/patient search reduction

« Protection of mobile equipment and saving on its cost by increasing
the objectivity of its movement registration and downtime reduction

« Objective staff workload calculating

« Optimization of MPI's departments, record and reduction of
total medical expenses for each patient

21




Patient Interaction System

Targets: easy interaction between MPI and their patients.

Health care service for a patient at a distance with help of phone,

Internet, self-service terminal including:

* new patient registration;

« control of doctor appointments: registration, confirmation, coun-
sel, information of appointment status, automatic notification be-
fore an appointment;

« helpful information: doctor appointment consultant, information
on preparing the patient for research/analysis;

« information of prescriptions, diagnostic and analysis results;
« control of these prescriptions.
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Patient Interaction System
Architecture

:

E-mail
WWW Site

Patient Interaction Syste: o
e MPI /=
= = =
=2 ==
swpintment| 1
,7] | —

Self-service
USSD/SMS IVR Terminal
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TESTS

Theme number 1

Nol

The EXPLORE button of the standard Windows window is intended for
5.00: maximize the window in full screen monitor

0.00: minimize the window

0.00: return to the original view window

Ne2

Windows have:

0.00: many colors

0.00: same value

5.00: the same control buttons and appearance

Ne3

Is it possible for several programs to work simultaneously in Windows?
0.00: no

0.00: sometimes

5.00: yes

No4

If you type WIN at the command prompt and press the Enter button, then
0.00: text is highlighted

0.00: computer shuts down

0.00: this is necessary to save information on disk

5.00: Windows will boot

No5

Specify the correct file name
0.00: nc.exe / exe

0.00: professor_doc

5.00: prof.exe

0.00: p?24. txt

Ne6

A text editor is needed for:

5.00: Typing and editing text
0.00: Printing text on paper

0.00: Writing text to a floppy disk
0.00: Mail

Ne7

The graphic editor is intended for:

5.00: Creating and editing graphic images
0.00: Leisure activities

0.00: Cartooning

0.00: Holographic image processing



No8

File - this is:

5.00: Part of the program or the whole program
0.00: Run command

0.00: Program Group

0.00: Diskette Part

No9

File name extension indicates to:
5.00: File Type

0.00: How to run the program
0.00: What volume of information
0.00: file name

NelO

Choose the correct file name
5.00: BABY.EXE

0.00: B ? Y.BABY

0.00: EXE. + 2

0.00: HELLO.EX

Nell

In order, to interrupt the operation of the program need to press
0.00: Enter

0.00: Caps Lock

5.00: Esc

0.00: Alt

Nel2

The computer will automatically recognize the program by
0.00: length

5.00: extension

0.00: latin letters

Nel3

In order to turn off the computer in Windows it is necessary
0.00: select the necessary operation command

0.00: press the Power button

5.00: turn off all programs, then exit Windows and press Power

Nel4

The EXPLORE button of the standard Windows window is intended for
5.00: maximize the window in full screen monitor

0.00: minimize the window

0.00: return to the original view window

Nel5
The BLOCK NOTE program is intended for



0.00: Drawing Pictures
0.00: Creating and editing tables
5.00: Creating and editing small texts

Nel6

To save the file under a new name, use the command:
0.00: create

0.00: open

0.00: save

5.00: save as

0.00: save all

Nel7

The taskbar serves to

5.00: switching between running applications
0.00: Windows shutdown

0.00: data exchange between applications
0.00: running DOS programs

0.00: view directories

Nel8

The tetris.com file is located on drive C : in the GAMES directory, which is subdirec-
tory of the DAY directory. Select full file name:

0.00: C:\tetris.com\ GAMES \ DAY

0.00: C:\GAMES \tetris.com

5.00: C:\DAY \ GAMES \ tetris.com

0.00: C:\GAMES\DAY \tetris.com

0.00: C:\GAMES \tetris.com

Nel9

To move a piece of text from one place in a document in another it is necessary to ex-
ecute the commands y (' s):

0.00: Copy, Paste

0.00: Cut

5.00: Cut, Paste

0.00: Save, Paste

0.00: Paste

Neo20

Text and image editors are:
0.00: texts and figures
5.00: programs

0.00: data banks

0.00: database

Ne21

The minimum set of functions that must perform text editor, not included:
0.00: save files

0.00: file upload



0.00: text formatting
5.00: work with graphics
0.00: text editing

Ne22

Program is

5.00: file or group of files designed to perform a task
0.00: wire between the monitor and the system unit
0.00: computer network

Ne23

Use a computer to solve math problems
0.00: not allowed

5.00: it is possible

Ne24

Windows is

0.00: company name
0.00: processor type
5.00: operating system
0.00: word processor
0.00: graphical editor

Ne25

In which menu are the teams with which we work collected with document files
5.00: File (file)

0.00: Format

0.00: View Take (kind of)

No26

What extension do executables have?
5.00: .exe

0.00: .com

0.00: .doc

0.00: .txt

0.00: .bmp

Neo27

How does the Notepad program start?
0.00: select Start menu

5.00: double-click on its icon

0.00: by clicking on its icon

No28

In which menu are the teams with which we work collected with document files?
5.00: File (file)

0.00: Format

0.00: View Take (kind of)



used

menu

No29

What is part of Windows?
5.00: File Manager

0.00: WORD

0.00: MS Excel

No 30
To exchange text and graphic information between open windows documents can be

5.00: clipboard
0.00: database
0.00: dialog box

No31

What is the insertion point of an object?
0.00: character insertion mode

0.00: inverse line position

5.00: text cursor position

No32

How to paste text into a text document from a buffer?

0.00: move the cursor to the place of text entry and type text

5.00: move the cursor to the desired location and select the command B to put in the

0.00: type text and move to the desired location

Ne33

What is a menu?

0.00: list of objects that appears on the screen
5.00: list of teams

0.00: sequence of records grouped together

No34

How to unselect text?

0.00: select the menu command in the Highlight

5.00: click with the mouse anywhere in the window outside the selected area
0.00: double-click outside the selected area

Ne35

What is horizontal and vertical intended for scroll bars?
0.00: for word processing

5.00: to scroll through the editor window

0.00: to scroll through tables and texts

Ne36

The tools in the graphics editor are ...
0.00: line, circle, rectangle

0.00: highlight, copy, paste

5.00: pencil, brush, eraser



0.00: color sets (palette)

Theme number 2

Nel

What is called the minimum unit of textual information?
0.00: offer

0.00: line

5.00: symbol

0.00: story

Ne2

The «End» key sets the cursor:
0.00: start of line

0.00: top of page

5.00: end of line

0.00: end of paragraph

Neo3

Which key deletes the character to the right of the cursor?
0.00: Page Down

0.00: Insert

0.00: Backspace

5.00: Delete

0.00: Page Up

Ne4

Which key deletes the character to the left of the cursor?
5.00: Backspace

0.00: Insert

0.00: Page Down

0.00: Delete

0.00: Page Up

No5

What letter is typed when you press the key combination Shift + S (bI), if the key-
board works in Russian capital letters mode?

5.00: capital letter S

0.00: S (b1)

0.00: lowercase letter v

0.00: lowercase letter s

0.00: capital letter S

Neb6

Which key is used to reject the selected action, to exit from the menu?
0.00: Enter

5.00: Esc

0.00: Alt

0.00: Shift

0.00: Insert



menu

Ne7

Key for connecting digital mode additional keyboard?
0.00: Insert

0.00: Page Down

5.00: Num Lock

0.00: Caps Lock

0.00: scroll

No8

Which key moves the cursor to the beginning of the line?
0.00: End

0.00: Page Up

0.00: Esc

5.00: Home

0.00: Page Down

Ne9

Pressing the Shift key together with any letter key will result in:
0.00: computer freezes

0.00: user change

5.00: capitalization

0.00: spacing between letters

0.00: digits appear

NelO

Font Type - All Except
0.00: normal

0.00: italics

0.00: bold

5.00: special

Nell

To navigate typed text using the keyboard keys apply
0.00: alphanumeric

0.00: functional

5.00: management

Nel2

How to paste a fragment of text or picture into a document from the clipboard?
0.00: move the cursor to the place of text entry and type text

5.00: move the cursor to the desired location and select the command B to put in the

0.00: type text and move to the desired location

Nel3

How to paste a fragment of text or picture into a document from the clipboard?
0.00: Ctrl + C

0.00: Ctrl + W



5.00: Ctrl + V
0.00: Ctrl + X
0.00: Ctrl + Z

Nel4

In all cases, does WORD need to go to a new line press enter ?
0.00: as you wish

5.00: no

0.00: yes

Nel5

The document page in which the text cursor is located is called
0.00: special

5.00: current

0.00: normal

Nel6

WORD can be used on Windows to work with
0.00: spreadsheets

5.00: text documents

0.00: text programs

Nel7

WORD is an integral part
0.00: MS DOS

5.00: Microsoft Office
0.00: Windows

Nel8

What extension do work files in WORD have?
-2.50:.ex e

2.50:. docx

-2.50:. bat

2.50:. doc

Nel9

To undo the last action, you need

0.00: double-click anywhere on the screen
5.00: press Cancel button

0.00: in the File menu, select the Exit command

Ne20

To undo the last action, you need
0.00: Ctrl + C

5.00: Ctrl + Z

0.00: Ctrl + W

0.00: Ctrl +V

0.00: Ctrl + X



No21

To select an arbitrary sequence of characters, you need

a) set the cursor to the left of the first character and press the left button mouse, with-
out releasing it, select text

b) enter the menu and select the command in the Highlight

c) set the cursor to the left of the first character and press Enter

5.00: a

0.00: b

0.00: c

Ne22

Working files in which application have the extension .doc?
0.00: MS Access

0.00: MS Excel

5.00: MS WORD

0.00: Paint

0.00: MS PowerPoint

No23

What does the gray (faded) color of the menu command in WORD mean?
5.00: this menu command is currently unavailable

0.00: after selecting this command a dialog box will appear

0.00: this command is currently available

Neo24

What is called a symbol?

0.00: arbitrary sequence of letters and numbers

5.00: minimum unit of text information

0.00: arbitrary sequence of words between two points

Ne25

In WORD used fonts
0.00: WORD

5.00: Windows

0.00: Excel

0.00: Access

No26

What is horizontal and vertical intended for scroll bars?
0.00: for word processing

5.00: to scroll through the editor window

0.00: to scroll through tables and texts

No27

Why do we use the Page Layout tab?
0.00: to insert pagination

0.00: to insert a table

0.00: to change page color

0.00: to check spelling



5.00: to arrange transfers

Ne28

In the row "symbol " - ... - " line" - "text fragment" is missing:
5.00: "word"

0.00: paragraph

0.00: page

0.00: text

No29

The character entered from the keyboard during typing is displayed on the screen. dis-
play at the position determined by:

0.00: settable coordinates

5.00: cursor position

0.00: address

0.00: by the position of the previous letter typed

Ne30

When typing, one word is separated from another:
0.00: point

0.00: comma

5.00: space

0.00: colon

Ne31

The text editor menu is:

a) part of its interface, providing the transition to execution various operations on the
text

b) a subprogram that provides PC resource management when document creation

c) a kind of "window" through which the test is viewed on the screen

d) information about the current state of the text editor

5.00: a

0.00: b

0.00: ¢

0.00: d

Ne32

Text editing is:

0.00: the procedure for saving text to disk as a text file

5.00: process of making changes to the existing text

0.00: process of transmitting text information over a computer network
0.00: procedure for reading previously created text

Ne33

Set the format use sequence patterned:

1) Put the cursor on the paragraph in the format of which will be produced formatting
2) left-click on the desired paragraph

3) Select a brush tool

4) The mouse pointer becomes a brush



0.00:1,2,3,4
0.00:2,3,4,1
0.00:1,3,4,2
0.00:4,3,2,1

No34

What is a font size?
0.00: letter tracing
0.00: font type

5.00: letter height size

No35

Which keyboard key should be pressed to join below the paragraph if the text cursor is
at the end of the current paragraph?

0.00: Enter

0.00: BackSpace

5.00: Delete

0.00: Esc

Ne36

How to single out one word in the text of a document?
0.00: double-click the right mouse button on the word
0.00: left-click on a word

0.00: right click on the word

5.00: double-click the word left mouse button

Ne37

What extension do Word 2007 document files have?
0.00:. xIs

0.00: .rtf

5.00:. docx

0.00: .jpeg

0.00: .pdf

No38

To deselect text in Word, you need to:
5.00: click anywhere in the document area
0.00: close document

0.00: restart the computer

0.00: save document

Ne39

What is a document template?

1) file containing document settings

2) a file in which statistics about the document are stored

3) a file that is a working copy of an open file

4) a file that stores information about the content of the created document
5.00: 1

0.00: 2



0.00: 3
0.00: 4

Ne40

A file containing document settings, such as elements AutoText , fonts, assigned key-
board shortcuts, macros, menus, page options, formatting and styles

0.00: sample document

0.00: document preparation

5.00: document template

0.00: example document

N4 1

What is Microsoft Office Word for?

0.00: to create animations, multimedia objects

5.00: for creating, viewing and printing text documents

0.00: for creating presentations, i.e. performance illustrations
0.00: to create spreadsheets

Ne4?2

When, when entering text into a document, press Enter in a Word program?
5.00: at the end of each paragraph

0.00: after each word

0.00: at the end of each page

0.00: at the end of each line

Ne43

Name the main function of the MS Word screen item "Rulers"
0.00: contains the name of the program and the current document
0.00: contains buttons of the most frequently used commands
5.00: shows field boundaries, position and types of tabs

Ne44

What font settings can | change?

1.67: size

1.66: tracing

-2.50: offset relative to document fields
1.67: letter spacing

-2.50: word spacing

Ne45

How to save a previously created document under a different name?
5.00: use the C save as command

0.00: use the command Send

0.00: use the command C safeguard

0.00: use the command With proof create

Ne46
What font styles are there?
1.25: italics



-5.00: thickened
1.25: bold

1.25: bold italics
1.25: normal

No47

What is called formatting?

-2.50: change document save options
-2.50: replace text

2.50: change paragraph settings
2.50: change font settings

N4

To print an active Word document, click
0.00: Home - Printing

0.00: Insert - Print

0.00: View - Print

5.00: Office - Print

Ne49

Choose the fastest way to select the entire document
0.00: hold the left mouse button, stretch down

0.00: select the first word, hold Shift, select the last word
0.00: Home - Select - Select All

5.00: Ctrl + A

No50

In a word processor, the Copy operation becomes possible after:
0.00: setting the cursor in a specific place

5.00: selection of a fragment of text

0.00: save file

No51

When typing, a space is set:
5.00: after the punctuation mark
0.00: to punctuation mark

0.00: before and after the sign

No52

Italicization is achieved by a key combination
0.00: Ctrl + A

0.00: Ctrl + Shift + Space

0.00: Ctrl + Backspace

5.00: Ctrl + 1

0.00: Ctrl + U

Ne53
Bold text is achieved by a keyboard shortcut
5.00: Ctrl + B



0.00: Ctrl + Shift + Space
0.00: Ctrl + Delete

0.00: Ctrl + 1

0.00: Ctrl + Z

No54

The default quick access toolbar is located
5.00: top of the Word window

0.00: next to the clock

0.00: to the right of the start button

0.00: on the main tab

Ne55

Punctuation marks . ,:; ! ? are written:
5.00: merged with the word followed by
0.00: space after word followed by

No56

Non-printing characters (control characters) are intended for :
0.00: grammar checks in a document

5.00: Correct and fast text formatting

0.00: move through the document

0.00: finding stylistic errors

Ne57

Between the words put:

5.00: one space

0.00: two spaces

0.00: spaces are placed automatically

No 58

A non-breaking space is inserted using the key combination:
0.00: Ctrl + N

5.00: Ctrl + Shift + Space

0.00: Ctrl + Delete

0.00: Ctrl + Alt + Delete

0.00: Ctrl + shift + 8

Ne59

Shift + F 10 keyboard shortcut :
0.00: closes the document

5.00: calls the context menu
0.00: calls the start menu

0.00: reboots the PC

0.00: opens the Save File menu

Ne60
Command Cut achieved by a combination of keys:
5.00: Ctrl + X



0.00: Ctrl + Shift + Space
0.00: Ctrl + O
0.00: Ctrl +P
0.00: Ctrl +S

Theme number 3

Nol

The standard font for official documents In the Russian Federation is:
5.00: Times New Roman

0.00: Arial

0.00: Tahoma

0.00: Calibri

No2

Changing the case for typed text is possible:

0.00: selecting text and pressing Tab on the keyboard

0.00: Ctrl + Shift

5.00: by pressing the button on the Main tab in the Font group
0.00: style change

Ne3

The heading level in the text is determined by:
0.00: page number

5.00: number format in the header

0.00: order in the text

0.00: font size

Ne4

Go to the appropriate section through the Table of Contents:
0.00: achieved by double-clicking

0.00: achieved by pressing Shift + left mouse button

0.00: achieved by pressing Shift + right mouse button

5.00: achieved by pressing Ctrl + left mouse button

0.00: impossible

No5

Auto hyphenation function in the window Microsoft Office Word is located:
0.00: on the main tab

5.00: on the Page Layout tab

0.00: in the context menu

0.00: on the View tab

Ne6

In a text editor, when setting page parameters, the following are set:
0.00: Headset, size, style

0.00: Indent, interval

5.00: Fields, orientation

0.00: Style, template



Ne7

To correct a mistake in the word should:

0.00: send fault report

0.00: right-click on a word and select an option
0.00: restart the computer

0.00: contact help and support using F 1

No8

How to quickly select a sentence in a text?

a) while holding the CTRL key, click on any word in the sentence
b) move the pointer to the left edge of the line so that

he turned into an arrow pointing to the right, after which

click the mouse

c) double-click the text

0.00: a

5.00: b

0.00: in

Ne9

The style is called:

a) a set of font formatting options

b) a set of formatting options that apply to text, tables, and lists to quickly change
them appearance

c) paragraph formatting options

d) the way to align the text of the paragraph

0.00: a

5.00: b

0.00: ¢

0.00: d

Nel0

How does zooming a document affect to print a document?
0.00: increases font size when printing

5.00: no effect

0.00: requires page resizing

0.00: increases the size of drawings when printing

Nell

How can | go into the mode of creating or editing footers?

0.00: by double-clicking on the vertical ruler

5.00: by double-clicking in the upper or lower margin of the document
0.00: using the Footer group on the Main tab

0.00: using the Structure command from the “View” menu

Nel2

How can | go into the mode of creating or editing footers?
0.00: by double-clicking on the vertical ruler

0.00: by double-clicking on the horizontal ruler

5.00: using the Header and Footers group on the Insert tab



0.00: using the Structure command from the “View” menu

Nel3

The Font item on the Main tab allows:
0.00: restart Word program

0.00: set bullet list

5.00: set the font type, color, size and style
0.00: break text into columns

Nol4

To center the title, you must

0.00: press Tab until the text is centered

5.00: press the P button about the center in the Paragraph group
0.00: press Spacebar until the text is centered

Nel5

What kind of alignment is not in the MS Word Processor?
5.00: height alignment

0.00: right alignment

0.00: left align

0.00: center alignment

Nel6

The number of the current page of the document can be seen:
0.00: on the main tab

5.00: in the status bar

0.00: upper right corner of the Word window

0.00: in the Quick Access Toolbar

0.00: in the context menu

Nel7

How to fix the error if you accidentally deleted part of the text?
2.50: click About Cancel on the Quick Access Toolbar

-2.50: press P repeat on the Quick Access Toolbar

2.50: keyboard shortcut Ctrl + Z

-2.50: keyboard shortcut Ctrl + Shift + F8

Nol8

You have highlighted several lines in the document. Why is the size in the field font
on the main tab has the value disappeared?

0.00: Characters in selected text are too large

5.00: Symbols in the selected text have different sizes

0.00: Character size not set in selected text

0.00: Characters in selected text are too small

Nel9

How to quickly select text at the end of a line using keyboard keys?
0.00: SHIFT + HOME

5.00: SHIFT + END



0.00: SHIFT + right arrow

No20

How to quickly select text at the beginning of a line using keyboard keys?
5.00: SHIFT + HOME

0.00: SHIFT + END

0.00: SHIFT + right arrow

No21

What mode allows you to display in the process of working with a document him the
way he will be printed?

0.00: Structure Mode

0.00: Normal mode

0.00: Page Layout

5.00: Document preview mode

No22

What sets the indent option on the left 2 cm in the Paragraph dialog box?
0.00: Offset the entire paragraph 2 cm to the left of the left margin

5.00: Offset the entire paragraph 2 cm to the right of the left margin
0.00: Page margin size

0.00: Offset only the first row 2 cm to the left of the left margin

No23

The clipboard stores several different fragments. Is it possible paste multiple frag-
ments from the clipboard at the same time?

5.00: yes, any number of fragments

0.00: yes, but only nearby fragments

0.00: yes, but only all fragments at once

0.00: no

Neo24

How can | remove all pagination in a Word 2007 document?
2.50: press U to delete page numbers in the Page Number menu
2.50: delete one of the numbers in the header change mode
-2.50: save the file with a new name

-2.50: by pressing Ctrl + Alt + Delete

Ne25

How to delete a number only on the first page of a document?

5.00: by clicking the Special footer for the first page in the Design tab
0.00: by clicking Custom footer for the first page in the View tab
0.00: delete one of the numbers in the header change mode

Ne 6

How to insert an express block into a document?
0.00: Insert-Text Box -Add Label

5.00: Insert-Text-Express blocks

0.00: Page Layout-Text-Express Blocks



aries

No27

How are special characters inserted?
0.00: typed on the keyboard

0.00: copied from other documents
0.00: copied from templates

5.00: Insert tab Symbol button

No28

How to insert current time and date into a document?
5.00: Insert-Text-Date and time

0.00: Page Layout - Date and Time

0.00: Links-insert link

0.00: Links-Insert footnote

No29
Creating an AutoCorrect element is performed:
0.00: Button Office Parameters Word -Pravopisanie (correct writing)-Custom diction-

0.00: Links- Word Options-Spelling- AutoCorrect Options
5.00: Button Office Parameters Word -Pravopisanie (correct writing)-

Options AutoCorrect

Ne30

How to change pages in the Table of Contents when changing them in the text:
5.00: press About Refresh table in the Table of Contents menu

0.00: re-create the table of contents

0.00: enter page numbers using keyboard

Theme number 4

Nel

The standard indentation for the first line is:
5.00: 1.25 sm

0.00: 0.7 sm

0.00: 1.0 sm

0.00: 2.0 sm

No2

You can adjust the fields in the document:

1.66: choosing from the list when clicking the Fields button
1.67: manually

-2.50: by clicking the Size button on the Page Layout tab
1.67: in the Custom Fields menu

-2.50: adjusting the scale

Neo3

The default sheet orientation is
0.00: large book

5.00: book



0.00: landscape
0.00: diagonal

No4

The indentation in the document is governed by:
5.00: buttons in the paragraph group

0.00: buttons in the Font group

0.00: buttons in the Page Settings group

Ne5

You can set a specific numerical value for the indentation in the document:
0.00: in the window of the Font button

5.00: in the Paragraph button window

0.00: in the Office Button Options menu

Ne6

The indentation of the first line can be changed:
2.50: in the Paragraph button window

-2.50: in the window of the Font button

2.50: using the top ruler

-2.50: using the side ruler

No7

By default, the line spacing in the document should be set:
0.00: double

0.00: one and a half

0.00: multiplier

5.00: single

Neo 18

Center text alignment should be performed:
0.00: repeatedly pressing Space

5.00: combination Ctrl + E

0.00: by pressing Tab

Ne9

Center text alignment should be performed:

0.00: repeatedly pressing Space

0.00: Ctrl + | combination

0.00: by pressing Tab

5.00: with the same button in the paragraph group

NelO

Right alignment should be performed:
5.00: Ctrl + R combination

0.00: repeatedly pressing Space

0.00: by pressing Tab

Nell



Center text alignment should be performed:

0.00: repeatedly pressing Space

5.00: with the same button in the paragraph group
0.00: Ctrl + U combination

0.00: by pressing Tab

Nel2

The graphic image of the formula is inserted into the Word document :
0.00: regular characters

0.00: from the Symbol menu on the Insert tab

5.00: using the Formula toolbox in the Symbols group

0.00: from the graphical editor Paint

Nel3

The graphic image of the formula is inserted into the Word document :
5.00: using the Eq field in the Express Blocks menu

0.00: from the graphical editor Paint

0.00: regular characters

0.00: from the Symbol menu on the Insert tab

Nel4

You can exit the footer editing menu by pressing:
0.00: Ctrl + Alt + Delete Combinations

5.00: Esc keys

0.00: Alt + F 4 combinations

Nel5

Lists in a document can be:
2.50: numbered

-2.50: simple

-2.50: difficult

2.50: labeled

Nel6

Lists in a document can be:
2.50: numbered

2.50: multi-level

-2.50: ordered

-2.50: chaotic

Nel7

Which field is not among compulsory at registration of the title page:
0.00: department head

5.00: rector

0.00: teacher

0.00: performed

Nel8
In column B performed during registration of the title page is not indicated



0.00: Surname of the author
0.00: Course

0.00: Group Number

0.00: Faculty

5.00: home address

Nel9

The footers in the document are located:
2.50: at the top of the sheet

2.50: bottom of sheet

-2.50: on the left side of the sheet

-2.50: on the right side of the sheet

No20

It is possible to avoid captions in the footer area on the first sheet:
5.00: by selecting the Special footer option for the first page
0.00: manually deleting them

0.00: in the menu of the button View and print

No21

Clip-art objects are intended for:

0.00: inserting video clips into a document
5.00: insert graphic clips into a document
0.00: drawing in the document field

No22

What are WordArt objects?

0.00: Drawing tools in the document field

5.00: A variety of graphic shapes in the text area
0.00: Table creation tool

0.00: Macro Recording Tool

No23

How is it possible to go to a new page, not filling out the previous one completely?
2.50: inserting Page Break from the Insert tab

-2.50: Enter repeatedly

2.50: inserting a page break with the key combination Ctrl + Enter

-2.50: repeatedly pressing Space

No24

The output of the document for viewing and printing is possible:
2.50: by clicking the View and print icon

2.50: keyboard shortcut Ctrl + P

-2.50: keyboard shortcut Ctrl + B

-2.50: by pressing a button on the printer

Ne25
You cannot add to the footer:
0.00: ClipArt object



5.00: video clip
0.00: building blocks

No26

Footnotes in the document are intended for:

0.00: plagiarism protection

5.00: add comments, indicate the source of information
0.00: document orientation

No27

The index in the document is:

0.00: item name index

5.00: a list of terms found in the document
0.00: table of contents

0.00: where the cursor is positioned

No2§

Choose your list options in Microsoft Word documents
1.67: numbered

1.67: marked

-1.66: drop down

-1.67: two-level

-1.67: ordered

1.66: layered

No29

What points can we implement when printing a document?
1.25: Select a printer

1.25: Specify printing multiple pages on one

-5.00: Indicate printing 5 pages on one

1.25: Print single pages only

1.25: Select to print multiple copies

Ne30

A Word 2007 document has a cover page. Which tab Should I use to select a different
cover page?

0.00: Home

5.00: Insert

0.00: Links

0.00: Review

Theme number 5

Nel

Where is the Shapes team located?
5.00: Insert - Hlustrations

0.00: Insert - Text

0.00: Home - Paragraph

0.00: View - Window



No2

Flowchart tool in Microsoft Office Word bears the name :
0.00: WordArt

5.00: SmartArt

0.00: ArtHouse

0.00: ArtViewer

Ne3

Purpose of using illustrations in text documents:
1.67: improved perception

-2.50: solidifying a document

1.67: help in memorizing material

1.66: motivation for action

-2.50: uplifting

Ne4

What type of SmartArt drawing is optimal for displaying inconsistent information?
0.00: Cycle

0.00: Process

5.00: List

0.00: Hierarchy

0.00: Communication

No5

What type of SmartArt drawing is optimal for displaying process steps or timeline?
0.00: Cycle

5.00: Process

0.00: List

0.00: Hierarchy

0.00: Matrix

Ne6

What type of SmartArt drawing is optimal for displaying continuous process?
0.00: Pyramid

5.00: Cycle

0.00: List

0.00: Hierarchy

0.00: Communication

Ne7

How can | add a table to a document?
1.67: draw with the Pencil tool

-2.50: draw using Shapes

1.67: Insert - Table - Insert table
-2.50: Insert - Figure

1.66: Insert - Table - Express tables

No8
To move between cells, you can use:



-2.50: Space
2.50: Tab

2.50: Shift + Tab
-2.50: BackSpace

Ne9

To go to the next cell in the table, you must use:
0.00: Space

0.00: Ctrl

0.00: Shift

5.00: Tab

NelO

To move between cells, you can use:
-2.50: Space

-2.50: Delete

2.50: Tab

2.50: arrow keys

Nell

To move between cells, you can use:
2.50: Mouse pointer

-2.50: Space

-2.50: Shift + Esc

2.50: Shift + Tab

Nel2

To return to the previous cell in the table, you must use:
0.00: Shift + Space

5.00: Shift + Tab

0.00: Shift

0.00: Tab

Nel3

It is possible to select the entire table:

1.67: by clicking on the square symbol in the upper left corner of the table
-2.50: keyboard shortcut Ctrl + A

1.67: using the left mouse button

-2.50: using the right mouse button

1.66: select the first cell , while holding Shift , select the last cell

Nel4

How can cells be combined?

2.50: select cells and select About merge cells in the context menu
2.50: using the Eraser tool

-2.50: using the H tool draw a table

-2.50: select cells and press Delete

Nel5s



How can I split a cell?

2.50: using the H tool draw a table

-2.50: select cells and press Enter

2.50: select the context menu of a specific cell P azbit cell
-2.50: using the Eraser tool

Nel6

Where is the function for inserting express tables?
0.00: Insert - Shapes

5.00: Insert - Table

0.00: Insert - Express Blocks

0.00: Insert - Caption

Nel7

How the value of calculations in the cell is updated when changing the initial numeri-
cal values in the cells?

0.00: automatic

0.00: only when inserting the formula again

5.00: About the update field command

0.00: About command to clean the field

Nel8

How is the insertion of a diagonal line in Word table cell ?
0.00: using the Shapes - Lines function

5.00: using the H tool draw a table

0.00: using the function P beat cells

Nel9

Using which function is it possible to change the background of cells in Word table?
0.00: Font - Text color

0.00: Font - Text highlight color

5.00: Constructor - Fill

Ne20

How is it possible to align the width of columns in a Word table?

a) select the columns and select In Align in the context menu row height

b) select the columns and select In Align in the context menu column width
¢) manually, moving borders

d) using the function Merge cells

0.00: a

5.00: b

0.00: ¢

0.00: d

Ne21

How can | change the thickness of the lines (borders) of the table?
0.00: select the table and go to the menu Borders and fill

0.00: by choosing the Layout tab - Cell Fields



5.00: select the thickness of the line and specify the desired borders with
Tool H arisovat table

0.00: using the lines in the Shapes menu

2.50:a

-2.50: b

2.50:c

-2.50: d

Ne22

When performing calculations in Word tables, the LEFT function touches:
0.00: cells located in the row to the right of the cell with the formula

5.00: cells located in the row to the left of the cell with the formula

0.00: cells located in the row above the cell with the formula

0.00: cells located in the row below the cell with the formula

No23

When performing calculations in Word tables, the RIGHT function touches:
0.00: cells located in the row to the left of the cell with the formula

5.00: cells located in the row to the right of the cell with the formula

0.00: cells located in the row above the cell with the formula

0.00: cells located in the row below the cell with the formula

No24

When performing calculations in Word tables, the ABOVE function touches:
0.00: cells located in the column to the left of the cell with the formula

0.00: cells located in the column to the right of the cell with the formula
5.00: cells located in the column above the cell with the formula

0.00: cells located in the column below the cell with the formula

No25

When performing calculations in Word tables, the BELOW function touches:
0.00: cells located in the column to the left of the cell with the formula

5.00: cells located in the column below the cell with the formula

0.00: cells located in the column to the right of the cell with the formula
0.00: cells located in the column above the cell with the formula

No26

It is possible to add rows to the end of the table:

1.67: placing the cursor to the right of the last cell and pressing Enter
1.66: highlighting the last line and pressing B put lines below

-2.50: using the R command to kill cells

1.67: use the H tool to draw a table

-2.50: inserting a new table from the bottom

Neo27

How to make a shape contour invisible?

5.00: Select a shape - Shape styles - Outline - No outline
0.00: change the color of the lines to white

0.00: using the Eraser tool



menu -

range?

No28

It is possible to set the exact value of the column width in the table:
0.00: by choosing Layout - Properties - Cell

5.00: by choosing Layout - Properties - Column

0.00: manually moving borders

No29

To insert a formula into a cell in a Word table:

5.00: place the cursor in the cell - select Layout - Formula

0.00: place the cursor in the cell, put the = sign, enter the formula
0.00: place the cursor in the cell - select Insert - Formula

Ne30

Adding a column to a table is possible:

1.67: select a column, next to which you need to insert a column and select B in
set - select columns to the right or left

1.66: use the P command to kill cells

-2.50: using the O merge cells command

1.67: use the H tool to draw a table

-2.50: select a column and press Ctrl + N

Theme number 7
Nel
In spreadsheets, the range of cells A1:B3 is highlighted. how many cells are in this

0.00: 3
0.00: 4
0.00: 5
5.00: 6
0.00: 12

No2

How are the lines on the working field of the Ex program with el marked?
0.00: Points.

0.00: Letters.

5.00: Figures.

0.00: Pictures.

0.00: Nothing

Ne3

When calculating a formula in a cell, an error message appears *lattice*. It means
0.00: invalid argument value in the formula

0.00: that the name used in the formula is not recognized

0.00: the divisor in the formula takes the value? H ul?

0.00: invalid data type

5.00: cell overflow

Ne4



Where is the contents of the current cell displayed?
0.00: In status bar

0.00: In the upper left corner under the standard toolbar
0.00: On a horizontal formatting ruler

5.00: In the formula bar

0.00: Not displayed anywhere

Ne5

In EXCEL with spreadsheet cells you cannot perform the following actions:
0.00: enter and correct information

0.00: copy and delete information

5.00: resize one individual cell

0.00: mark and unmark

Ne6

What are the columns on the Ex workspace with el marked?
0.00: Points.

5.00: Letters.

0.00: Pictures.

0.00: Nothing

No7

What does the $ symbol mean in cell name record B $ 2?

0.00: only the column number will not change in the address.

5.00: only the line number will not be changed in the address.

0.00: the cell name will remain unchanged.

0.00: the beginning of the range is strictly fixed and does not change when copying
0.00: this cell will be given an arbitrary name

Neg

A spreadsheet formula cannot include:
0.00: cell names

0.00: numbers

5.00: drawings

0.00: text

0.00: signs of arithmetic operations

Ne9

What is displayed in the cell after writing the formula and pressing the Enter key?
0.00: Record of the formula itself, an equal sign and the result of the calculation.
0.00: Special characters

5.00: The result of calculating the formula based on the available data.

0.00: Nothing displayed.

0.00: Just numbers.

NelO

How to write the formula for summing the cell range from b2 to b8?
0.00: = sums (b2, b8)

5.00: = sums (b2: b8)



0.00: = sums (b2-b8)
0.00: = sums (b2; b8)
0.00: = sums (b2 + b8)

Nell

When building the EXCEL diagram, it turned out to be empty. Why?
0.00: Not enough RAM.

0.00: Invalid chart type selected.

0.00: Data in the selected area is too small.

5.00: A block of data cells is not selected.

0.00: The chart does not fit on the screen because it is too large.

Nel2

When calculating the formula in the cell, a message appeared about the error
NeNAME? It means:

0.00: invalid argument value in the formula

0.00: that the name used in the formula is not recognized

0.00: the divisor in the formula takes the value? H ul?

0.00: cell overflow

5.00: wrong data type

Nel3

A group of 8 cells was selected in the spreadsheet. Could these be cells?
0.00: A1:BS8

0.00: Al1:C4

5.00:Al1:B4

0.00:B2:C4

0.00: A2:B4

Nel4

A spreadsheet cell is called current if:
0.00: cell visible on screen

0.00: it contains information

0.00: cell is empty

0.00: cell contains the formula

5.00: the cursor is in it

Nel$5

The range of cells in the spreadsheet is

0.00: many cells forming an arbitrary shape region
0.00: many filled cells in a spreadsheet

0.00: a lot of cells forming a rectangular area
0.00: many empty cells in a spreadsheet

5.00: many square-shaped cells

Nel6

The cell address of the spreadsheet is

0.00: name consisting of any sequence of characters
0.00: name consisting of column name and row number



0.00: address of the byte of RAM allocated for the cell
0.00: address of the machine word of random access memory allocated to the cell
5.00: name consisting of column number and row number

Nel7

The introduction of the formula into the cell begins with the sign:
0.00: plus

0.00: minus

0.00: stars

0.00: lattice

5.00: equalities

Nel8

The introduction of the formula into the cell ends:
0.00: moving to another cell

5.00: by pressing the Enter key

0.00: closing the sheet

0.00: activating the formula bar

Nel9

To select a range of cells, you must:

a) move the mouse cursor to the column numbering and click left mouse button

b) clicking on the upper left cell of the range and not releasing left mouse button, bring
to the bottom right cell range

c) move the mouse cursor to line numbering and click left mouse button

d) move the mouse cursor to the intersection of the numbering of columns and rows in
the upper left corner of the whole table and click the left mouse button

0.00: a)

5.00: b)

0.00: ¢)

0.00: d)

No20

To select the entire column of cells, you must:

a) move the mouse cursor to the column numbering and click left mouse button

b) clicking on the upper left cell of the range and not releasing left mouse button, bring
to the bottom right cell range

¢) move the mouse cursor to line numbering and click left mouse button

d) move the mouse cursor to the intersection of the numbering of columns and rows in
the upper left corner of the whole table and click the left mouse button

5.00: a)

0.00: b)

0.00: ¢)

0.00: d)

Ne21
To select the entire row of cells, you must:
a) move the mouse cursor to the column numbering and click left mouse button



b) clicking on the upper left cell of the range and not releasing left mouse button, bring
to the bottom right cell range

c) move the mouse cursor to line numbering and click left mouse button

d) move the mouse cursor to the intersection of the numbering of columns and rows in
the upper left corner of the whole table and click the left mouse button

0.00: a)

0.00: b)

5.00: ¢)

0.00: d)

No22

To select the whole list of cells you need:

a) move the mouse cursor to the column numbering and click left mouse button

b) clicking on the upper left cell of the range and not releasing left mouse button, bring
to the bottom right cell range

c) move the mouse cursor to line numbering and click left mouse button

d) move the mouse cursor to the intersection of the numbering of columns and rows in
the upper left corner of the whole table and click the left mouse button

0.00: a)

0.00: b)

0.00: ¢)

5.00: g)

Theme number 8

NeO1.

Select the main types of diagrams in Excel :
-2.50: Linear

1.67: Histogram

1.67: Circular

-2.50: Circumference

1.66: Graph

Ne(2.

The main elements of the diagram include:
2.50: Chart name

-1.67: Chart font name

2.50: Name of the ordinate of the chart
-1.67: Chart file name

-1.66: Chart data series name

Ne03.

The main elements of the diagram include:
1.67: Elements of the legend

-2.50: name of the legend

1.67: legend

1.66: Legend Key

-2.50: Legend Font

Ne(4.



The main elements of the diagram include:
-2.50: Rows of Permanent

1.67: Data Series

-2.50: Rows of logical operators

1.67: name of the abscissa

1.66: Ordinate Name

Ne05.

The main elements of the diagram include:
1.67: Data Labels

-2.50: legend tags

1.67: Build Area

-2.50: Data area

1.66: chart area

Ne(6.

What type of chart will you choose for analysis:
0.00: Histogram

0.00: Pie chart

5.00: Schedule

0.00: Inside the bar graph

Ne(Q7.

What type of chart will you choose to identify interestratios:
0.00: Histogram

5.00: Pie chart

0.00: Graph

0.00: Inside the bar graph

Ne(8.

What kind of diagram will you choose for the most clarity:
0.00: Histogram

5.00: Pie chart

0.00: Graph

0.00: Inside the bar graph

Ne(9.

What type of chart do you choose for the most informative:
0.00: Histogram

0.00: Pie chart

5.00: Schedule

0.00: Inside the bar graph

Nel0.

The Chart Tool contains tabs
-1.67: View

1.67: Constructor

-1.67: Data

1.67: Layout



1.66: Format
-1.66: Font

Nell.

Using the Designer tab, you can perform the following operations:
2.50: Chart type selection

-2.50: Formula selection

2.50: Layout selection

-2.50: Font style selection

Nel2.

The Design tab contains panels:
2.50: Data

-1.25: Sort

-1.25: Signatures

-1.25: Paste

-1.25: Size

2.50: Location

Nel3.

The Layout tab contains panels:
-1.25: Data

-1.25: Sort

2.50: Signatures

2.50: Paste

-1.25: Size

-1.25: Location

Nel4,

The Format tab contains panels:
-1.25: Data

2.50: Sort

-1.25: Signatures

-1.25: Paste

2.50: Size

-1.25: Location

Nels.

Which tab on the ribbon contains the Illustrations panel:
0.00: Home

5.00: Insert

0.00: Links

0.00: Page Layout

Nel6.

What native objects are used in Excel?
-1.67: Photos

2.50: WordArt Objects

2.50: SmartArt Drawings



-1.67: Video files
-1.66: Audio files

Nel7.

What external objects can be imported and pasted into Excel:
1.67: Photos

-2.50: WordArt objects

-2.50: SmartArt Drawings

1.67: Video files

1.66: Audio files

Nel8.

Legend is:

a) descriptive text along axes

b) a signature with additional data marker information
c) descriptive text centered at the top of the chart

d) a frame in which patterns or colors of rows or categories are defined chart data
0.00: a)

0.00: b)

0.00: c)

5.00: d)

0.00: a), ¢)

0.00: b),d)

Nel9.

The Chart Title is:

a) descriptive text along axes

b) a signature with additional data marker information
c) descriptive text centered at the top of the chart

d) a frame in which patterns or colors of rows or categories are defined chart data
0.00: a)

0.00: b)

5.00: ¢)

0.00: g)

0.00: a), ¢)

0.00: b), d)

Ne20.

The name of the axes is:

a) descriptive text along axes

b) a signature with additional data marker information
c) descriptive text centered at the top of the chart

d) a frame in which patterns or colors of rows or categories are defined chart data
5.00: a)

0.00: b)

0.00: ¢)

0.00: g)

0.00: a), ¢)

0.00: b), d)



No 21.

Data labels are:

a) descriptive text along axes

b) a signature with additional data marker information
c) descriptive text centered at the top of the chart

d) a frame in which patterns or colors of rows or categories are defined chart data
0.00: a)

5.00: b)

0.00: c)

0.00: d)

0.00: a), ¢)

0.00: b), d)

Theme number 9

Ne 01

The general complex is

0.00: part of the objects of the complex
5.00: all studied objects

0.00: imaginary objects

Ne 02

The sample complex is

a) retaining all the properties of a real object

b) maintaining the essential properties of a real object
¢) not preserving a single property of a real object
5.00: part of the objects of the complex

0.00: all studied objects

0.00: imaginary objects

Ne 03

Quantitative features of the objects of the complex are characterized by:
0.00: numerical definition

5.00: numerical distribution

0.00: numeric name

No 04

The characteristics of numerical distributions include parameters:
1.67: average

1.67: variance

1.66: standard deviation

-5.00: average deviation

Ne 05

Estimation of a numerical parameter can be
1.25: pitting

-2.50: rough

-2.50: not rude



1.25: interval
1.25: offset
1.25: unbiased

Ne 06

A point estimate of the general characteristic is called selective characteristic:

a) which is the number that is used in as an approximate value of the unknown general
characteristics

b) which is determined by two numbers: the ends of the interval covering the
estimated parameter

5.00: a)

0.00: b)

Ne 07

The interval estimate of the general characteristic is called selective characteristic:

a) which is the number that is used in as an approximate value of the unknown general
characteristics

b) which is determined by two numbers: the ends of the interval covering the
estimated parameter

0.00: a)

5.00: b)

Ne 08

In the field of biometry, the types of statistical criteria are used:
-2.50: accurate

2.50: parametric

2.50: nonparametric

-2.50: not accurate

Ne 09

Parametric criteria are criteria:

a) built on the basis of the parameters of this population and representing the functions
of these parameters

b) representing functions that depend directly from a variant of this aggregate with
their frequencies

5.00: a)

0.00: b)

NelO

Nonparametric criteria are criteria:

a) built on the basis of the parameters of this population and representing the functions
of these parameters

b) representing functions that depend directly from a variant of this aggregate with
their frequencies

0.00: a)

5.00: b)

Nell
Student's method of comparing the mean values of two samples refer to:



0.00: exact methods

5.00: parametric methods
0.00: nonparametric methods
0.00: inaccurate methods

Nel2

Functional link is link

a) in which each specific value is independent the variable corresponds to the only
value of the dependent variable

b) in which each specific value is independent variable corresponds to more than one
value of the dependent variable

5.00: a)

0.00: b)

Nel3

Correlation is a relationship

a) in which each specific value is independent the variable corresponds to the only
value of the dependent variable

b) in which each specific value is independent variable corresponds to more than one
value of the dependent variable

0.00: a)

5.00: b)

Nel4

The degree of connection between the phenomena is estimated using
a) correlation coefficient

b) standard deviation

c) dispersion

5.00: a)

0.00: b)

0.00: ¢)

Nel5

The degree of connection between the phenomena may be
a) weak

b) moderate

c) strong

d) complete

¢) be absent

0.00: a) e) c)
0.00:b)a)c)d)
0.00:c)a)b)d)
5.00: d)a)b)c)e)
0.00: d) d)

Nel6

Determining the average of a numerical distribution in Excel using the Function
Wizard, you can carry out in the tabs:

a) mathematical



b) statistical

¢) financial

d) logical

e) 10 recently used
0.00: a) ¢)

0.00: b) e)

0.00: c) b)

0.00: g) e)

5.00: d) b)

No 17

Determining the standard deviation of a numerical distribution in Excel using the
Function Wizard, you can carry out in the tabs:

a) mathematical

b) statistical

¢) financial

d) logical

e) 10 recently used

0.00: a) ¢)

0.00: b) e)

0.00: c) b)

0.00: g) e)

5.00: d) b)

Nel8

Determining the correlation coefficient of samples in Excel using the Function Wizard,
you can carry out in the tabs:

a) mathematical

b) statistical

¢) financial

d) logical

e) 10 recently used

0.00: a) ¢)

0.00: b) e)

0.00: ¢) b)

0.00: g) e)

5.00: d) b)

Nel9

To determine the average value, you must activate the function
5.00: AVERAGE

0.00: STD

0.00: CORREL

0.00: TEST

Ne20

To determine the standard deviation function must be activated
0.00: AVERAGE

5.00: STD



0.00: CORREL
0.00: TEST

Ne 21

To determine the linear correlation coefficient function must be activated
0.00: AVERAGE

0.00: STD

5.00: CORREL

0.00: TEST

No 22

To apply the student method function must be activated
0.00: AVERAGE

0.00: STD

0.00: CORREL

5.00: TTEST

Theme number 10

Ne 01

The database is:

0.00: part of the objects of the population
0.00: all studied objects

0.00: data set

5.00: structured data set

0.00: imaginary objects

Ne 02

Types of database structuring:
1.67: network

1.67: hierarchical

1.66: tabular

0.00: designer

Ne 03

The table database field names are displayed:
0.00: in lines

5.00: in the first line

0.00: in columns

0.00: in the first column

Ne 04

Table database entries displayed:
5.00: in lines

0.00: in the first line

0.00: in columns

0.00: in the first column

Ne 05



The fields in the table database are displayed:
0.00: in lines

0.00: in the first line

5.00: in columns

0.00: in the first column

Ne 06

Limitations on Database Structure

a) the first row of the database must contain non-duplicate field names
b) records contain empty rows

¢) field information should be uniform

0.00: a)

0.00: b)

5.00: ¢) a)

0.00: b) ¢)

Ne 07

Limitations on Database Structure

a) field information may be heterogeneous

b) contain records that are not empty rows

c) the first row of the database must contain duplicate field names
0.00: a)

5.00: b)

0.00: c) a)

0.00: b) ¢)

No 08

Limitations on Database Structure

a) field information may be heterogeneous

b) field information should be uniform

c) the first row of the database must contain duplicate field names
0.00: a)

5.00: b)

0.00: ¢) a)

0.00: b) ¢)

Ne 09

Limitations on Database Structure

a) the first row of the database must contain non-duplicate field names
b) the first row of the database must contain duplicate field names

¢) records contain empty rows

5.00: a)

0.00: b)

0.00: c) a)

0.00: b) ¢)

Nel0
DBMS is:
0.00: managed database structure



0.00: universal database system
5.00: database management system

Nell

What is the main work with the database?

0.00: in the data set

0.00: in data table entry

5.00: in the search for information on certain criteria
0.00: in creating databases

Nel2

Excel refers to DBMS?
5.00: no

0.00: yes

Nel3

Excel manages many databases?
5.00: no

0.00: yes

Nel4

Excel manages a single database?
0.00: no

5.00: yes

Nel5

What options are used to search information on certain criteria in the database
a) Filter

b) Insert

c¢) Data

5.00: a) ¢)

0.00: b)

0.00: a) b)

0.00: ¢)

0.00: b) ¢)

Theme number 11

Ne 01

Specify the program that creates the files with the extension .ppt:
5.00: Power Point

0.00: Excel

0.00: Access

0.00: Word

0.00: Paint

Ne 02
A program designed to create and edit presentations:
0.00: Paint



5.00: Power Point
0.00: Access
0.00: Word

0.00: Excel

Ne 03

What is a presentation?

0.00: Self-introduction

0.00: Theatrical performance

5.00: This is a set of slides and special effects used for display on the screen
0.00: A set of pictures

0.00: A set of text files

Ne 04

What command is used to insert a chart and a fragment of the data table to it on a slide
in PowerPoint 20077

5.00: Insert Chart

0.00: Start-Figure-Chart

0.00: Taskbar-Organization Chart

0.00: File-Import

Ne 05

Which version of Power Point allows you to save your presentation as video file?
0.00: All versions allow

0.00: All of the following versions do not allow

0.00: Power point 2003

0.00: Power point 2007

5.00: Power point 2010

Ne 06

The minimum element of the presentation within which the content is:
0.00: Template

0.00: Presentation

0.00: Layout

5.00: Slide

0.00: Animation

Ne 07

The hotkey for pasting clipboard information into MS PP is:
0.00: Esc

0.00: Ctrl + P

5.00: Ctrl +V

0.00: Alt+R

0.00: Shift

Ne 08

Tools for formatting text contains:
0.00: Office Button

5.00: Home tab

0.00: Design tab



0.00: Menu? Start?
0.00: Review tab

No 09

The optimal number of sentences on one slide for the most convenient perception of
information:

0.00: 1-2 sentences

0.00: 10-20 sentences

5.00: 3-5 offers

0.00: 50-100 offers

0.00: 100-120 offers

NelO

To change the presentation topic you need:

0.00: Open the Add-Ins tab

0.00: On the Animation tab, select Slide Change

5.00: In the Themes group of the Design tab, click the desired document theme
0.00: Click Start? Run? Change Themes

0.00: This option does not exist

Nell

To select the desired option to move the slide to another slide you need:
0.00: Click File? Create? New transition option

0.00: On the Formatting tab, select a group. Go to this slide

0.00: On the Home tab, select the Animation group.

5.00: On the Animation tab, select the group Go To This Slide

0.00: Click Start? Run? Slide transition

Nel2

To switch from Slide Show Mode to Normal Mode you need to:
0.00: press the F5 key

0.00: press the caps lock key

5.00: press the Esc key

0.00: just move the mouse cursor

0.00: do not click anything

Nel3

How many operating modes are presented in MS PP?
5.00: 3

0.00: 2

0.00: 1

0.00: 4

0.00: There are no operating modes in MS PP

Nel4

How to proportionally resize inserted pictures, photos:
0.00: Horizontal

5.00: Diagonal

0.00: Vertical



Nel5

What actions can be performed on slides in the mode? Slide sorter ??
0.00: Insert SmartArt elements into slides

0.00: Change the contents of the selected slides

0.00: Adding Graphics and Tables

5.00: Removing whole slides

0.00: Removing text from individual slides

Nel6

In which of the following modes of the text formatting command will be unavailable?
0.00: Mode? Normal?

5.00: Mode? Slide Show?

0.00: Inaccessible in any mode

0.00: Available in any mode

Ne 17

What command can add Excel tables in MS PP?

0.00: Left-click and select Table

0.00: On the Animation tab, select the Insert command.
5.00: Table command in the Insert tab

0.00: On the Review tab, Excel team

0.00: No such command

Nel8

With the .PPTM file extension, the MS PP presentation is saved:
0.00: With table

5.00: With macro support

0.00: With clip support

0.00: With multiple drawings

0.00: With support for animation elements

Nel9

List the elements that can be entered on the slide:
0.00: Text

0.00: Tables

0.00: Charts

0.00: Pictures

5.00: All of the above is true

Ne20
If the text on the slide goes beyond the text placeholder, then it (the place) can be

increased by following these steps:

left?

1) Click File? Create? New placeholder

2) On the Home tab, select the Edit command

3) Select the placeholder, move the mouse pointer to its borders

and after changing the shape of the cursor, stretch

4) Select the placeholder and press one of the keys? Up ?,? Down ?,? right? or? to the



5) Such an action cannot be performed.
0.00: 1)
0.00: 2)
5.00: 3)
0.00: 4)
0.00: 5)

Ne21

What is the most convenient way to design a slide?

0.00: Bright red text on a black background

0.00: The borders of the inserted photo or picture coincide with the borders of the slide
0.00: Black text on a bright green background

5.00: There is a gap between the border of the slide and the inserted photo

Ne 22

What are animation effects used for?
0.00: To transmit fun information

0.00: To overload the presentation

5.00: To attract the attention of the public
0.00: For the entertainment of the public

No 23

Which of the following fonts is best used in a presentation?
5.00: Arial

0.00: Symbol

0.00: Wingdings

0.00:Any Gothic

Ne 24

What needs to be done to accurately position various objects on a slide?
0.00: Objects can be positioned with the mouse? By eye?

5.00: Objects can be positioned using guides

0.00: Objects themselves are positioned

0.00: Objects can be positioned using a wooden ruler

No 25

What does the concept include? Unified styling ??

0.00: The same number of slides on all presentations

0.00: Mandatory presence on all slides of animation effects
5.00: Single color and typeface, single background color
0.00: A single number of photos on each slide

No 26

What information is desirable to place on the first slide of the presentation?
0.00: Brief conclusions on the topic of presentation

0.00: List of literature used to create a presentation

0.00: Thanks to the public for the attention given

5.00: On what topic and by whom the presentation was created



Ne 27

Charts, drawings, photographs are used in the creation of the presentation as:
5.00: As additional to text information

0.00: As entertainment information

0.00: As advertising information

Ne 28

The main findings of the report are:

0.00: On the first slide of the presentation

5.00: On the final slide of the presentation
0.00: On an intermediate presentation slide
0.00: The report does not draw any conclusions

No 29

How to add a fixed date?

0.00: Fixed dates cannot be added to presentations

5.00: The Date and Time command on the Insert tab
0.00: Command Add to menu? Start?

0.00: The Date and Time command on the Formatting tab

Ne30

With what extension do you need to save the presentation so that it always opened in a
slide show?

0.00: .doc

0.00: .ppt

5.00: .ppsx

0.00: .pptm

Ne 31

The collection of slides collected in one file form:
0.00: impression

5.00: presentation

0.00: frames

0.00: drawings

Theme number 12

Nel

Internet proxy server

0.00: provides the user with a secure communication channel

0.00: allows you to encrypt electronic information

5.00: provides anonymization of access to various resources

0.00: used for the exchange of electronic signatures between subscribers

Ne2
As you know, the IP address of a computer consists of four numbers, separated by
dots. Each of the numbers of the IP address can take decimal values from O to:

5.00: 255



0.00: 256
0.00: 999
0.00: 192

Ne 3

Instant messaging system called
0.00: HTP

5.00: ICQ

0.00: URL

0.00: GPS

Ne4

POP works on the Internet

0.00: mail server for sending messages
5.00: mail server for receiving messages
0.00: file sharing management server
0.00: hypertext transfer server

No5

Service system with which you can communicate through the network Real-time
internet with other people, has the name

0.00: Windows Chat

0.00: Slideshare

0.00: FTP

5.00: IRC

Ne 6

The term “communication channel” in computer science means

a) telephone, telegraph or satellite communications; and hardware used to transmit
information

b) a technical device providing signal coding when transmitting it from an information
source to an information receiver

c) a set of technical devices providing reception electric discharge information in a
circuit

5.00: a)

0.00: b)

0.00: ¢)

Ne 7

In order to go online, you need the following
5.00: modem, computer, telephone line

0.00: printer, computer, modem, scanner
0.00: modem, printer, driver, memory

0.00: monitor, mouse, keyboard, system unit

Neg

The Internet - this is:
0.00: local area network
0.00: corporate network



5.00: global network
0.00: regional network

N9

The address of the Internet server is set: www.ksma.ru.Top Domain Name level is
0.00: www.ksma.ru

0.00: ksma.ru

5.00: ru

0.00: www

Nel0

The host organization of the WAN site is
0.00: host computer (host)

5.00: provider

0.00: server

0.00: domain

Nell

The IP address is as follows:
5.00: 193.126.7.29

0.00: 34.89.45

0.00: 1.256.34.21

0.00: edurm.ru

Nel2

Transport Protocol (TCP) provides

a) delivery of information from the sending computer to the recipient computer

b) receiving, transmitting and issuing a single communication session

¢) user access to processed information

d) splitting files into ip-packets in the process of transferring and assembling files in
the process

0.00: a

0.00: b

0.00: in

5.00: g

Nel3

WWW is:

0.00: Wide World Web
0.00: Web Wide World
0.00: World Web Wide
5.00: World Wide Web

Nel4

Email allows you to transfer:
0.00: messages only

0.00: files only

5.00: messages and attached files
0.00: attached files only



Nel5

The connection of a word or image with another resource is called
0.00: Webpage

5.00: Hyperlink

0.00: URL

0.00: Website

Nel6

The email subscriber's mailbox is

a) some area of RAM of the file server

b) the area on the hard drive of the mail server allocated for the user
c) part of the memory on the hard disk of the workstation

d) a special electronic device for storing text files

0.00: a

5.00: b

0.00: in

0.00: g

Ne 17

Programs for viewing web pages are called
0.00: viewers

5.00: browsers

0.00: multimedia programs

0.00: by email

Nel8

Select a top-level domain on the Internet belonging to Russia.
0.00: kz

0.00: .org

0.00: .net

5.00: .ru

Nel9

Which browser is part of the Windows operating system?
5.00: Internet Explorer

0.00: Netscape Navigator

0.00: Windows Mesenger

0.00: Opera

Ne20

Modem this device is designed to

0.00: Print information

0.00: Information storage

0.00: Processing information at a given time

5.00: Transmission of information via telephone communication channels

Ne 21
Hypertext? this is:



0.00: very large text

0.00: text typed on a computer

0.00: text that uses a large font

5.00: text in which transitions can be made on selected marks

Ne 22

Data rate- this is

5.00: the number of bits of information transmitted through the modem per unit time
0.00: number of bytes of information transferred from one computer to another
0.00: time for which the computer connects to the Internet

0.00: number of bytes of information stored on the server

No 23

Internet page address starts with
5.00: http: //

0.00: mail: //

0.00: http: // mail

0.00: mail

Ne 24

Web pages may have a format (extension)
0.00: .txt

5.00: .htm

0.00: .doc

0.00: .exe

No 25

Domain this is

0.00: unit of information

5.00: part of the address that defines the address of the user's computer on the network
0.00: name of the program for communication between computers

0.00: name of the device communicating between computers

No 26

Specify the purpose of the Internet FTP service

5.00: File Transfer Service

0.00: Real-time communication service (chat conference)
0.00: Testing Service

0.00: Weather forecast service

Neo 27

WWW (World Wide Web)? literally means
5.00: World Wide Web

0.00: teleconference

0.00: local area network
0.00: email

Ne 28
A dedicated computer dedicated to sharing network participants is called



5.00: server
0.00: admin
0.00: directory
0.00: disk

No 29

In order to open a site in Internet Explorer, which you recently visited
5.00: find his address in the Journal

0.00: change connection settings

0.00: restart browser

0.00: click on the Home button

Ne30

To make calls on the Internet, you must have special programs
0.00: Word, Excel, etc.

5.00: Skype, Messenger and others .

0.00: Power Point et al .

0.00: Internet Explorer e al .

Ne 31

On the menu — Favorite- Internet Explorer programs are stored
0.00: addresses of all sites in the world

0.00: list of the most popular sites in the world

5.00: addresses of sites that you often visit

0.00: list of all sites you have ever visited

Ne 32

Information on the Internet can be found using
0.00: email services

0.00: Browser Log

5.00: search sites

0.00: Internet telephony services

Ne 33

Which country does the domain part of bks mail.online.kz point to?
0.00: USA

5.00: Kazakhstan

0.00: Russia

0.00: Germany

Ne 34

Network protocol is
0.00: www

5.00: PPP

0.00: ECP

0.00: URL

Ne 35
Administrative device independent communication networks it



0.00: host

5.00: router

0.00: domain

0.00: hub

Ne 36

The speed of data transmission over the network at the physical layer network OSI or
TCP / IP models can be measured in

0.00: kb / min

0.00: Kbps

0.00: Kb /s

5.00: Kbps

Ne 37

Local Area Network hardware includes

0.00: workstations, personal computers

5.00: workstations, server, communication equipment
0.00: communication equipment, server

No 38

Computers can be connected to each other using
0.00: twisted cable

0.00: optomagnet cable

0.00: photoelectric cable

5.00: coaxial cable

Ne 39

A device is used to interface a computer with one communication channel
0.00: hub

5.00: adapter

0.00: repeater

0.00: bridge

Ne 40

When transmitting information, it is mandatory Availability

0.00: two people

5.00: source and receiver of information, communication channel between them
0.00: media

0.00: worldwide computer network

Ne 41

To connect two computers over telephone lines, must have
0.00: modem on one computer

0.00: modem and network program on one computer

0.00: by modem on each computer

5.00: modem on each computer with a network program

Ne 42
A modem is a special peripheral device for
0.00: output information from a computer to paper



5.00: telecommunications
0.00: storage and transfer of information from computer to computer
0.00: copy and duplicate text documents

Ne 43
Computers in the same organization linked by transmission channels information for

sharing common resources and peripherals and located in the same building, called a network

0.00: regional
0.00: territorial
5.00: local
0.00: global

Ne 44
The option of connecting computers to each other when the cable passes from one

computer to another, sequentially connecting computers and peripherals between by yourself-

this is

5.00: linear bus

0.00: star type compound
0.00: tree topology

0.00: roundabout

Ne 45

Cable used to connect computers to LAN called
0.00: coaxial cable

5.00: twisted pair

0.00: fiber optic

0.00: all listed

Ne 46

A computer sharing its resources with other computer when working together, called
0.00: switch

5.00: server

0.00: modem

0.00: adapter

Ne 47

The local area network information transfer rate is usually found in the range
0.00: 10 to 100 Mbps

0.00: 10 to 100 Kbps

5.00: 100 to 500 bps

0.00: 10 to 100 bps

No 48

Networks connecting computers within the same region are called
0.00: local

5.00: regional

0.00: corporate

0.00: postage



Ne 49

Network protocol is

5.00: a set of agreements on interactions in a computer network

0.00: sequential recording of events occurring in a computer network

0.00: rules for interpreting data transmitted over the network

0.00: rules for establishing communication between two computers on a network
0.00: coordination of various processes in time

Ne50

Teleconference- this is

0.00: global email exchange

0.00: information system in hyperlinks

5.00: system for the exchange of information between subscribers of a computer
network

0.00: file reception and transmission service of any format

0.00: the process of creating, receiving and transmitting web pages

Ne 51

The local network is used for:

5.00: data exchange between computers
0.00: computer performance improvements
0.00: increase print speed

0.00: computer security

Ne 52

Computers are connected to a local network by:
0.00: connector

5.00: cable

0.00: loopback

0.00: telephone cord

Neo 53

Why do I need to know the name of a computer on the network?
0.00: in order to know the name of the user

0.00: for aesthetic look

5.00: to search for a computer on the network

0.00: in order to turn it off

Ne 54

What desktop icon is designed to work with the local network?
0.00: My computer

0.00: Cart

0.00: My documents

5.00: Network environment

Ne 55

Network printer- this is

0.00: laser printer

5.00: printer shared with individual users



0.00: printer on each computer on the local network
0.00: color printer

Ne 56

A folder that is fully shared allows other users to:
5.00: change the files in it

0.00: only view folder contents

0.00: only rename files in it

0.00: only copy files in it

Ne 57

Folder sharing settings open:

0.00: through the context menu of the network environment
0.00: when left-clicking on a folder

5.00: through the folder context menu

0.00: when double clicking on the folder

Ne 58

You can open access to a folder on your computer using the commands
5.00: context menu of the folder? Sharing and security? Access

0.00: Network environment? Sharing and security? Access

0.00: click on the folder? Sharing and security? Access

0.00: double click on a folder? Sharing and security? Access

Ne 59

What does the user need to know in order to find the computer he needs in the local
network?

0.00: does the computer have a connected printer

0.00: does the computer have a modem

0.00: system unit color

5.00: computer name

Ne 60

You can see which computers are in your workgroup using the commands:
5.00: Start? Network ? Display workgroup computers

0.00: My computer? Display workgroup computers

0.00: Start? Display workgroup computers

0.00: My documents? Display workgroup computers

Ne 61

Computer network protocol- this is:

0.00: program for communication of subscribers

5.00: a set of rules governing the exchange of information on the network
0.00: a program that allows you to convert information to ASCII codes

Ne 62

Local Area Network (LAN)- this is

5.00: network function within the unit or units of the enterprise
0.00: unification of computer networks at the state level



0.00: planetary networking

Ne 63

Symptom- Network typology- characterizes:

5.00: scheme of drive connections in the network (server and workstations)
0.00: how the network works

0.00: composition of technical means

Theme number 13

Ne 001.

The database is used for:

5.00: data storage and organization

0.00: conducting computational operations
0.00: text processing documentation

0.00: graphic information processing

Ne 002.

What makes up the table structure?
0.00: record

5.00: field

0.00: cell

0.00: column

Ne 003.

Field length is measured in:
5.00: bytes

0.00: millimeters

0.00: pixels

0.00: characters

Ne 004.

The text field allows you to enter information up to:
5.00: 256 characters

0.00: 20 characters

0.00: 65536 characters

0.00: 1 characters

Ne 005.

The auto-build property has a field:
0.00: numeric

5.00: counter

0.00: memo
0.00: logical

Ne 006.

Relational databases have:

0.00: statistics

5.00: fields of identical properties



0.00: required embedded objects
0.00: related tables

Ne 007.

A field is considered unique if:

5.00: its values are not repeated

0.00: its values are repeated

0.00: its length is minimal

0.00: his name is not duplicated in the database

Ne 008.

The key field should be:

0.00: certainly by the counter
0.00: required numeric

5.00: unique

0.00: must not contain long entries

Ne 009.

Ways to create MS Access tables:
0.00: using the constructor

0.00: using the wizard

0.00: by entering data

5.00: all answers are correct

Ne 010.

What is not an access database item?
5.00: panels

0.00: modules

0.00: macros

0.00: tables

Ne O11.

Records are considered:
0.00: headers

0.00: columns

5.00: lines

0.00: tables

Ne 012.

Logical data is:

0.00: cash data

0.00: text

5.00: one of two values
0.00: numbers

Ne 013.

To establish relationships between tables, use:
0.00: communication menu

5.00: Data Schema / Relationships button



0.00: Properties button
0.00: no correct answer

Ne 014.

Queries create to fetch data:
0.00: from multiple tables
0.00: from only one table
0.00: from other requests
5.00: from tables and queries

Ne 015.

What actions does the update request allow?
0.00: Display selected entries on screen

5.00: Change the values of the fields in the table
0.00: Add records to table

0.00: Delete records from the table

Ne 016.

Specify the wrong type of form
0.00: single

0.00: related

0.00: push button

5.00: settlement

Ne 017.

Indicate what actions are possible when working with a form in form mode?
0.00: Adding a record

0.00: Delete record

0.00: Editing tabular data

5.00: all answers are correct

Ne 018.

Work with reports is performed in the following modes:
0.00: Preview

0.00: Constructor

0.00: Sample

5.00: all answers are correct

Ne 019.

DBMS is:

5.00: this is a software package that implements all the necessary operations with
databases

0.00: special devices for creating and processing a database

0.00: a set of data related to a specific subject area

0.00: no correct answer

Ne 020.
A record in the database is:
0.00: table title



5.00: table row
0.00: table column
0.00: table cell

Ne 021

To start ACCESS you need to run the commands

0.00: Start - Documents - Microsoft Access

5.00: Start - Settings - Microsoft Access

0.00: Start - Programs - Accessories - Utilities - Microsoft Access
0.00: My Documents - Microsoft Access

Ne 022.

The most common types of relationships are:
0.00: one to many

0.00: many to many

0.00: one to one

5.00: all answers are correct

Ne 023.

In the database table containing three columns "Last Name", "First Name", "Phone"
200 people are entered. How many fields and records are in the table?

0.00: fields - 200, records - 3

0.00: fields - 600, records - 200

5.00: fields - 3, records - 200

0.00: fields - 3, records - 600

Ne 024.

The database contains information about the students of the school: last name, class,
grade for the test, grade for the practical task, the total number of points. What type of field
should be "Total points"?

0.00: character

0.00: logical

5.00: numeric

0.00: any type

Ne 025

The database file has the extension
0.00: .txt

0.00: .ppt

5.00: .mdb

0.00: .mbd

Ne 026.

Key Access Objects:

0.00: tables, forms, queries, reports, pages

0.00: queries, reports, forms, macros, tables

0.00: queries, reports, forms, macros, tables

5.00: tables, queries, forms, reports, pages, macros, modules



Ne 027

The underlying Access object is
0.00: form

5.00: table

0.00: report

0.00: module

Ne 028.

To enter, view and modify a table or query, the object is intended:
0.00: table

0.00: request

0.00: macro

5.00: form

Ne 029

Queries create to fetch data:
0.00: from multiple tables
0.00: from only one table
0.00: from other requests
5.00: all answers are correct

Ne 030.

To create a request:

5.00: Requests - Create
0.00: Insert - Request
0.00: Insert - Auto Query
0.00: Service - Parameters

No 031. As a result of the requests are created:
0.00: request forms

0.00: relational tables

0.00: result tables

5.00: reports

Ne 032

The calculated field in the request:
0.00: cannot be created

5.00: you can create

0.00: using the build button

0.00: using the Group operations button

Ne 033

Forms serve for:

0.00: editing table data

0.00: entering data into tables
5.00: both answers are correct
0.00: both are not true

Ne033



You can work with a form in the following modes:
5.00: all answers are correct

0.00: form constructor

0.00: forms

0.00: tables

Ne 034

The area of these forms consists of:
5.00: all answers are correct

0.00: fields

0.00: labels

0.00: headers

Ne 035

How to create a new form:
5.00: Forms - Create

0.00: Insert - Form

0.00: Tables - Create

0.00: Edit - Paste

Ne 036.

Ways to create forms:

0.00: summary table

0.00: chart

0.00: form wizard

0.00: constructor

5.00: all answers are correct

No 037

When creating forms use:
5.00: all fields of the table
0.00: tables and queries
0.00: background image
0.00: item bar

Ne 038

Appearance of the form:
0.00: single column

0.00: in one line

0.00: tape

0.00: tabular

5.00: all answers are correct

Ne 039

To automate data entry into forms, use:
0.00: switches

0.00: flags

5.00: list

0.00: windows



Ne 040

Reports are created for:

5.00: printing of the necessary information
0.00: data entry

0.00: display the information you need
0.00: fetch information

Ne 041

Reports are created based on:
0.00: base tables

5.00: requests

0.00: other reports

0.00: forms

Ne 042

Work with reports is performed in the following modes:
0.00: preview

5.00: all are true

0.00: sample

0.00: constructor

Ne 043.

The report structure contains the following parts:
0.00: header and footer

0.00: data area

0.00: report title

0.00: signature

5.00: all right

Ne 044,

Access data controls do not include:
0.00: fields

0.00: buttons

0.00: flags

5.00: everything applies

Ne 045.

The desired font in access can be set with the command:
5.00: format - font

0.00: text - format

0.00: table - font

0.00: view - format

Neo 046.

Which command sets toolbars?
0.00: insert

0.00: edit

5.00: view

0.00: file



Ne 047

Specify the wrong data type in access
0.00: text

5.00: parametric

0.00: numeric
0.00: logical

Ne 048

Specify invalid link types
0.00: one to one

0.00: one to many

5.00: two to one

0.00: many to many

Ne 049

The form provides opportunities for:

0.00: entering and viewing database information
0.00: data changes

0.00: print

5.00: all right

Theme number 14

Ne 001.

Automatic build property has a field:
0.00: numeric

5.00: counter

0.00: memo

0.00: logical

Ne 002.

Relational databases have:

0.00: statistics

5.00: fields of identical properties
0.00: required embedded objects
0.00: related tables

Ne 003.

What is not an access database item?
5.00: panels

0.00: modules

0.00: macros

0.00: tables

No 004.

Records are considered:
0.00: headers

0.00: columns

5.00: lines



0.00: tables

Ne 005.

Logical data is:

0.00: cash data

0.00: text

5.00: one of two values
0.00: numbers

Ne 006.

To establish relationships between tables use:
0.00: communication menu

5.00: data scheme / relationships button
0.00: property button / properties

0.00: no correct answer

Ne 007.

What actions does the update request allow?
0.00: display selected records on screen

5.00: change the values of the fields in the table
0.00: add entries to the table

0.00: delete records from the table

Ne 008.

Specify the wrong type of form
0.00: single

0.00: related

0.00: push button

5.00: settlement

Ne 009.

Indicate what actions are possible when working with the form in form mode?
0.00: add record

0.00: delete record

0.00: editing tabular data

5.00: all answers are correct

Ne 010.

Work with reports is performed in the following modes:
0.00: preview

0.00: constructor

0.00: sample

5.00: all answers are correct

No O011.

A record in the database is:
0.00: table title

5.00: table row

0.00: table column



0.00: table cell

Ne 012.

Queries create for data sampling:
0.00: from multiple tables

0.00: from only one table

0.00: from other requests

5.00: all answers are correct

Ne 013.

As a result of requests are created:
0.00: request forms

0.00: relational tables

0.00: result tables

5.00: reports

Ne 014.

Computed field in the request:

0.00: cannot be created

5.00: you can create

0.00: using the build button

0.00: using the group operations button

Ne 015.

You can work with the form in the modes:
5.00: all answers are correct

0.00: form constructor

0.00: forms

0.00: tables

Ne 016.

The form data area consists of:
5.00: all answers are correct
0.00: fields

0.00: labels

0.00: headers

Ne 017

When creating forms use:
5.00: all fields of the table
0.00: tables and queries
0.00: background image
0.00: item bar

Ne 018.
The appearance of the form may be:
0.00: single column

0.00: in one line
0.00: tape



0.00: tabular
5.00: all answers are correct

Ne 019.

To automate data entry into forms use:
0.00: switches

0.00: flags

5.00: list

0.00: windows

Ne 020

Reports are created for:

5.00: printing of the necessary information
0.00: data entry

0.00: display the information you need
0.00: fetch information

Ne 021

Reports are created based on:
0.00: base tables

5.00: requests

0.00: other reports

0.00: forms

Ne 022.

Work with reports is performed in the following modes:
0.00: preview

5.00: all are true

0.00: sample

0.00: constructor

Ne 023.

The report structure contains the following parts:
0.00: header and footer

0.00: data area

0.00: report title

0.00: signature

5.00: all right

Ne 024,

Access controls do not include:
0.00: fields

0.00: buttons

0.00: flags

5.00: everything applies

Ne 025
The desired font in access can be set with the command:
5.00: format - font



0.00: text - format
0.00: table - font
0.00: view - format

Ne 026.

Which command sets toolbars?
0.00: insert

0.00: edit

5.00: view

0.00: file

Ne 027

Specify the wrong data type in access
0.00: text

5.00: parametric

0.00: numeric
0.00: logical

Ne 028.

The form provides opportunities for:

0.00: entering and viewing database information
0.00: data changes

0.00: print

5.00: all right

Ne 029

When creating a request in constructor mode:
0.00: select information sources

0.00: selection conditions

5.00: indicate from which table

0.00: field composition

Ne 030.

In table access it is impossible
5.00: make calculations

0.00:. Enter data

0.00: change structure

Ne 031.

Which command sets toolbars?
0.00: insert

0.00: edit

5.00: view

0.00: file

Ne 032

What cannot be done with the access request?
0.00: grouping

0.00: sort



0.00: calculation
5.00: printing a document

Ne 033

Specify the wrong data type in access
0.00: text

5.00: parametric

0.00: numeric
0.00: logical

Ne 034

What does the SUMM function mean?

0.00: selects the minimum value in the records of a specific field
0.00: defines the first value in the specified field of records

5.00: calculates the sum of all values ofa given field

0.00: defines the last value in the specified field of records

Ne 035
Specify the wrong data type in access

0.00: text
5.00: basic
0.00: date
0.00: logical

Ne 036.

Which statement is true?

0.00: total queries are divided into 2 types

0.00: queries can be created based on data from several tables
0.00: grouping in the final query is made only for one field
5.00: all right

Ne 037

Specify the correct expression
0.00: table with parameter
0.00: form with parameter
5.00: request with parameter
0.00: report with parameter

Ne 038

What cannot be done in the access request?
0.00: grouping

0.00: sort

5.00: selection by condition

0.00: build chart

Ne 039
What cannot be done in the access request?
0.00: grouping



0.00: sort
0.00: conditional selection
0.00: build chart

Ne 040

Specify the wrong display mode (view) of the access form
5.00: request mode

0.00: table mode

0.00: form mode

0.00: constructor

Theme number 15

Nel

An information system is an object representing a combination of:
0.00: only homogeneous elements

0.00: only heterogeneous elements

0.00: homogeneous elements and heterogeneous elements

5.00: tools, software, methods and personnel

0.00: structured data

0.00: information software

No 2

Among the properties of information systems, the following are distinguished:
1.25: Dynamic

1.25: Development

1.25: Systematic Approach

-2.50: Consistency

-2.50: Static

1.25: Human Machine Environment

No 3

Any system is an object representing:

a) a highly specific part, an element of the whole

b) a set of only homogeneous elements

c) the totality of only heterogeneous elements

d) scoop of homogeneous elements and heterogeneous elements
e) a scoop of homogeneous and non-uniform elements as a whole
0.00: a)

0.00: b)

0.00: ¢)

0.00: g)

5.00: d)

Ne 4

The objectives of the implementation of information systems:

1.25: Creation of new information for solving management problems
1.25: Freeing Users from Routine Work

1.25: Replacing paper media with electronic

1.25: Reducing the cost of manufacturing products and services



-2.50 :: Creation of artworks
-2.50 :: Creation of material values

Ne 5

Types of classification of information systems:
2.50: Functional

-1.67: Modeling

2.50: Structural and technological

-1.67: By design

-1.66: By database

Ne 6

How many classes are distinguished in functional classification of information
systems

0.00: Three

0.00: Four

5.00: Five

0.00: Seven

0.00: Nine

Ne 7

What classes distinguish in functional classification medical information systems:
1.25: Medical Technology IP

-2.50: Static MIS

1.25: Educational MIS

-2.50: Supervisory 11As

1.25: Statistical IIAs

1.25: Research IP

Neo 8

Intensive Health Monitor Systems patients include:
5.00: Medical and technological IP

0.00: Static MIS

0.00: Learning MIS

0.00: Controlling MIS

0.00: Statistical I1As

0.00: Research IP

Ne 9

Computing diagnostics systems relate to:
0.00: Static MIS

0.00: Learning MIS

0.00: Controlling MIS

0.00: Statistical I1IAs

0.00: Research IP

5.00: Medical and technological IP

Ne 10
Clinical and laboratory research systems relate to:



0.00: Static MIS

5.00: Medical and technological IP
0.00: Learning MIS

0.00: Controlling MIS

0.00: Statistical I1As

0.00: Research IP

Ne 11

Expert systems relate to:

5.00: Medical and technological IP
0.00: Static MIS

0.00: Learning MIS

0.00: Controlling MIS

0.00: Statistical I1IAs

0.00: Research IP

Ne 12

Image transmission and processing systems relate to:
5.00: Medical and technological IP

0.00: Static MIS

0.00: Learning MIS

0.00: Controlling MIS

0.00: Statistical I1As

0.00: Research IP

Ne 13

Information system -Popular health- refers to:
0.00: Medical and technological IP

0.00: Static MIS

0.00: Learning MIS

0.00: Controlling MIS

5.00: Statistical I1IAs

0.00: Research IP

Ne 14

The information system - Habitat - refers to:
0.00: Medical and technological IP

0.00: Static MIS

0.00: Learning MIS

0.00: Controlling MIS

5.00: Statistical I1As

0.00: Research IP

Ne 15

The information system -Health institutions- refers to:
0.00: Medical and technological IP

0.00: Static MIS

0.00: Learning MIS

0.00: Controlling MIS



5.00: Statistical IIAs
0.00: Research IP

No 16

The information system - Healthcare personnel - refers to:
0.00: Medical and technological IP

0.00: Static MIS

0.00: Learning MIS

0.00: Controlling MIS

5.00: Statistical I11As

0.00: Research IP

Ne 17

The information system -Medical Industry- refers to:
0.00: Medical and technological IP

0.00: Static MIS

0.00: Learning MIS

0.00: Controlling MIS

5.00: Statistical I1As

0.00: Research IP

Ne 18

Organizational IP containing a description of the themes of the grands relate to:
0.00: Medical and technological IP

0.00: Static MIS

0.00: Learning MIS

0.00: Controlling MIS

0.00: Statistical I1IAs

5.00: Research IP

Ne 19

IP, controlling knowledge on the basis of the question-answer-relate to:
0.00: Medical and technological IP

0.00: Static MIS

5.00: Learning MIS

0.00: Statistical I1IAs

0.00: Research 1P

Ne 20

Specialist workstations correspond to the level of structural and technological
classifications:

5.00: level 1

0.00: 2 level

0.00: 3 level

0.00: 4 level

Ne 21
How many levels are distinguished when structurally technological classification of
information systems?



0.00: Three
5.00: Four
0.00: Five
0.00: Seven
0.00: Nine

Ne 22

Clinical Laboratory IPs are consistent level of structural and technological
classification:

5.00: level 1

0.00: 2 level

0.00: 3 level

0.00: 4 level

No 23

IP of dental departments correspond level of structural and technological
classification:

5.00: level 1

0.00: 2 level

0.00: 3 level

0.00: 4 level

Ne 24

Clinic IPs correspond level of structural and technological classification:
0.00: 1 level

5.00: level 2

0.00: 3 level

0.00: 4 level

No 25

IC diagnostic centers correspond level of structural and technological classification:
0.00: 1 level

5.00: level 2

0.00: 3 level

0.00: 4 level

Ne 26

IP of the regional ministry of health corresponds level of structural and technological
classification:

0.00: 1 level

0.00: 2 level

5.00: level 3

0.00: 4 level

No 27

Unified State Information System (EGIS) corresponds to the level of structural and
technological classification:

0.00: 1 level

0.00: 2 level



level:

0.00: 3 level
5.00: level 4

No 28
Which medical information systems presented below do not correspond to the third

a) IP of the territorial health authority
b) IP for solving medical and technological problems, providing information support

to the activities of medical workers of specialized medical services

¢) IS of polyclinics, hospitals
d) computer telecommunication medical networks that ensure the creation of a single

information space at the regional level.

card

0.00: a)
0.00: b)
5.00: ¢)
0.00: g)

Ne 29
To personalized registers include databases:

a) attached or observed contingent based on a formalized medical history or outpatient

b) to support doctors in counseling, diagnosis and decision-making in emergency

conditions

card

¢) preventive examination of the population and risk groups
d) various types of activities of the health care institution

5.00: a)
0.00: b)
0.00: ¢)
0.00: g)

Ne 30
The following systems are referred to screening systems:

a) attached or observed contingent based on a formalized medical history or outpatient

b) to support doctors in counseling, diagnosis and decision-making in emergency

conditions

c) preventive examination of the population and risk groups
d) various types of activities of the health care institution
0.00: a)

0.00: b)

5.00: ¢)

0.00: g)

Ne 31

How many levels have MIS health facilities:
5.00: Three

0.00: Four

0.00: Five



0.00: Seven
0.00: Nine

Ne 32

What tasks does the minimum level of MIS health care facilities solve:
1.67: statistics

1.67: maintenance of data to pay for treatment

1.66: interaction with the integration gateway (transmission, reception)
-1.67: maintaining all sections of the EMC

-1.67: interaction with analytical systems

-1.66: interaction with supporting healthcare facilities

Neo 33

What tasks are in addition to the tasks of the minimum IIA level? solves the basic
level of MIS health care facilities:

0.00: statistics

0.00: interaction with the integration gateway (transmission, reception)

5.00: maintaining all sections of the EMC

0.00: interaction with analytical systems

0.00: interaction with supporting healthcare facilities

Ne 34

What tasks in addition to the tasks of the minimum and basic levels of MIS are solved
by the advanced level of MIS of an MPI:

-1.25: statistics

-1.25: maintaining data to pay for treatment

-1.25: interaction with the integration gateway (transmission, reception)

-1.25: maintaining all sections of the EMC

2.50: interaction with analytical systems

2.50: interaction with supporting healthcare facilities



GLOSSARY

Access - a universal database management system. Designed to create and maintain
databases, to organize queries, all kinds of samples and reports. Contains tools for linking ta-
bles and for linking with other application packages.

Application: An application is a set of codes designed to allow specific tasks to hap-
pen. Microsoft Windows and Internet Explorer are common examples.

Application Server: Application Server is a specialized server that is based on cli-
ent/server architecture. Its sole responsibility is to run specific applications within the net-
work.

API: API refers to Application Programming Interface. It’s the platform used by a
program to access different services on the computer system.

Archivers - programs designed to compress selected files, place them in the archive
and write the resulting archive to a diskette. Naturally, the archiver must be able to unzip
files, that is, return them to their original state.

Archiving - the process of compressing a file or group of files.

Array: An array is similar data saved on a computer system in a sequential form.

BIOS: BIOS stands for Basic Input/Output System. It gives the computer a platform
to run the software using a floppy disk or a hard disk. BIOS is responsible for booting a PC.

Bit: Bit is Binary Digit. It refers to a digit number, either a 0 or a 1. The binary digit is
used to represent computerized data.

Boolean: An expression, the value of which is either true or false.

Buffer: Buffer is a location, especially in RAM, for storage of temporary data to speed
up an operation such as disk access or printing.

BUS: A bus is a set of wires that enables flow of data from one location of the com-
puter to another.

Byte: Eight bits is equal to 1 byte.

Cache memory is a buffer between the central processor and RAM and serves to in-
crease the speed of the computer.

Computer network. It occurs if at least two computers are connected together and
exchange information.

Compact disk (CD-ROM) - is designed to enter traditional programs and data, as well
as for multimedia.

CGI: CGI stands for Common Gateway Interface. It defines how an auxiliary program
and a Web server would communicate.

Class: A group of objects having same operations and attributes is defined as a class.

Client: A client is a program that asks for information from other processes or pro-
grams. Outlook Express is a great example of a client.

CMOS: CMOS is an abbreviation for Complementary Metal-Oxide-Semiconductor. It
is the battery powered chip that is situated on the Motherboard that retains system information
such as date and time.

Cursor - the moved visible mark used to indicate the position on the screen over
which the operation will be performed.

Data: Data refers to the information that is saved on a computer.

Database - a set of interconnected data stored in the external memory of a computer,
organized according to certain rules, providing general principles for their description, storage
and processing.

Directory - the named area of the disk. Used by the user to organize storage and fa-
cilitate the search for files.



Dialog box - a kind of window that allows the user to enter information into the com-
puter.

Dialog mode - the operating system operating mode in which it is waiting for a user
command, having received it, starts execution, and after completion returns a response and
waits for the next command.

DOS: DOS is an acronym for Disc Operating System. It is a command line operating
system launched by Bill Gates.

DTP: Desk Top Publisher (ing) is a term that describes a program that enables users to
create, design, and print items such as business cards, birthday cards, letterheads, calendars,
invitations, and so on.

Entity-relationship diagram: It’s a diagram that represents entities and how they are
related to each other.

Environment: Environment refers to the interaction among all factors external to a
physical platform. An environment is made of specific software, hardware, and network pro-
tocols that allow communication with the system.

Event Listener: It is an interface of JAVA responsible for handling events.

FAT: FAT is an acronym for File Allocation Table. It resembles a table of contents so
that files can be located on a computer.

Fault: Hardware or software failure.

File manager - a program that performs file system maintenance operations.

Front End: It is an interface through which a program can be accessed by common
users.

Hardware: Hardware is a set of physical objects such as monitor, keyboard, mouse,
and so on.

Hard magnetic disk (HDD) - external computer memory designed for permanent
storage of data, operating system programs and commonly used software packages.

Information - information about someone or something transmitted in the form of
signs and signals; in computer technology - data to be input into a computer stored in its
memory, processed on a computer and issued to the user.

Icon: Icon is a small visual display of an application which can be activated by click-
ing on it.

IDE: It stands for Integrated Development Environment. IDE is a programming sys-
tem that combines several tools of programming to provide an integrated platform for pro-
gramming. For instance, Visual Basic provides an IDE.

Instance: It is an object described by its class.

Internet: Internet is a network that accommodates several computers to facilitate ex-
change and transfer of data.

Kernel: It is a program called when a computer system is started. Kernel is responsi-
ble for setting up system calls in order to manage hardware and system services, and allocate
resources to applications.

Keyboard is a computer control keyboard device.

Keyboard shortcuts (Hotkeys) - a combination of the [ Shift ], [ Ctrl ], [ Alt ] keys
with other keys to perform operations when the mouse does not work for some reason.

LAN: LAN is an acronym for Local Area Network that spans small area. A LAN can
be connected to another LAN to accommodate more computers.

Memory: Memory is the internal storage location where data and information is
stored on a computer.



Modem: Modem is a term created from the beginning letters of two other words viz.
MOdulation and DEModulation. The term implies changing of data from digital to analog and
then back to digital.

Network: A Network is a group of computers connected to each other in order to send
and receive data.

Notepad is an editor program for working with small text files, included in standard
Windows programs.

Operating System: An Operating System provides the software platform required for
various applications to run on. Its responsibility is to manage memory storage and security of
Data.

Packet: Sections in which message or data are divided to transfer it over a network.

Paint is the default program WINDOWS OS and comes along with it.

Paragraph - a piece of text ending with pressing the Enter key.

Pixel: Pixel is formed by combining the two words viz. Picture Element. It represents
one point within an image.

Port: Port is a connecting component mainly a hardware that enables two computers
to allow data sharing physically. Examples are USB and HDMI.

Process: It’s a series of commands that changes data values.

Protocol: Protocol refers to a set of rules that are followed by two devices while inter-
acting with each other.

Query: Query is a request made by a computer from a database residing in the same
system or a remotely located system.

RAM: RAM is an acronym for Random Access Memory. It is a configuration of stor-
age cells that hold data so that it can be processed by the central processing unit. RAM is a
temporary storage location.

Recycle bin is the place where deleted files are automatically placed. You can option-
ally either restore them from there or throw them out of the Trash.

ROM: ROM is an acronym for Read-Only Memory. It is semiconductor-based storage
system that saves information permanently.

Software: Software is a program (coding) that the computer reads. The system then
carries out functions as directed by the code. Adobe Photoshop is software.

TCP/IP: TCP/IP is an acronym for Transmission Control Protocol/Internet Protocol.
It’s a set of communication protocols used to connect host computers on the Internet.

The clipboard - an area of RAM that all applications have access to and into which
they can write data or read it. Bit. This is the smallest unit of data. A bit can have one of two
values: either 0 or 1. Larger units of measurement of the amount of information - bytes, meg-
abytes, etc. One byte is 8 bits; one megabyte is 1024 bytes.

The folder name is set according to the same rules as the file name. We recommend
naming folders even more expressive and concise than files.

The file name consists of two parts. The first part, with the name itself, can be up to
255 characters long and consist of any characters, including a space, except \ /: * [? []), The
second part of the name, the extension, can contain any number of characters, if only the full
file name did not exceed 255 characters and did not contain prohibited characters.

The Root catalog - main directory or top-level directory.

URL: URL stands for Universal Resource Locator. It’s a way of accessing the Inter-
net.

Virtual Memory: Virtual Memory is the unused memory on the hard disk used when
certain applications require more RAM than is available on the machine.



Virus: Virus is a program that is loaded onto your computer without you knowing
about it and it runs to hinder the normal functioning of the computer.

WWW: WWW stands for World Wide Web. It’s a term used to define the Internet.

WAN: WAN is an acronym for Wide Area Network. Such a network spans over an
area larger than a LAN.

Window border - vertical and horizontal lines running along the perimeter of the
window.

Window title - the first line of the window containing the name of the application
running in this window, or the name of the dialog window.

Windows Document - any file processed using applications running on the Windows
operating system.

ZIP: ZIP is an acronym for Zone Information Protocol. ZIP application enables trans-
fer of data using compression of files.
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